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Introduction

Ce manuel est un introduction aux logiciels EDA (Electronic Desing Automation). Il n’a pas la
prétention de couvrir tous les aspects de ceux-ci. Ce manuel a pour objectif de permettre aux
étudiants de saisir le schéma de circuits logiques pour les simuler et les intégrer dans un PLD
(Programmable Logic Device, circuit logique programmable) . Il a été écrit afin de permettre une
approche simple et efficace du logiciel. Ce document comporte des indications spécifiques liées a la
configuration des logiciels utilisés au sein de l'institut REDS de la HEIG-VD. Cependant, il ne se
limite pas a résumer le mode d’emploi de divers logiciels, mais introduit une méthode de travail
permettant la réalisation complete de circuits numériques avec le langage VHDL.

Ce manuel permet, d’autre part, l'utilisation d’outils modernes pour la conception de circuits numé-
riques (logiciels EDA, Electronic Design Automation) associés aux nouvelles méthodologies.

1.1 OQutils pour la conception

de circuits La conception de circuits met en ceuvre quatre outils : un éditeur de texte/entrée gra-
phique, un simulateur, un synthétiseur et un placeur-routeur. Tous ces outils sont prévus pour
I'utilisation du langage VHDL.

1.1.1 HDL Designer (version 2007.1)

HDL Designer est un logiciel de gestion de projets et de saisie graphique utilisé dans la conception
de circuits numériques. La saisie graphique est une alternative a la saisie textuelle. Ce logiciel facilite
la gestion de projets et les saisies graphiques lors de la réalisation d’un systéme numérique en vue
d’une intégration dans un circuit logique programmable (CPLD ou FPGA). En plus de la fonction
d’entrée graphique, il sert a piloter d’autres logiciels comme le simulateur dont vous allez utiliser
les services lors des laboratoires. De cette maniere, vous n’aurez a connaitre qu’un unique logiciel.
Pour que cette collaboration fonctionne bien, nous avons paramétré certaines options afin que les
logiciels puissent communiquer entre-eux. Cela implique un respect scrupuleux de la mise en route
d’un projet, d’ou la présente documentation que nous vous demandons de suivre a la lettre.

1.1.2 ModelSim (version SE 6.3d)

Ce logiciel permet de simuler les descriptions réalisées afin de vérifier si elles respectent bien les
spécifications.

1.1.3 Precision Synthesis (version 2007a.8)

Ce logiciel effectue la synthese d’une description VHDL en un schéma logique équivalent. Celui-ci
est composé uniquement des fonctions logiques disponibles dans le circuit cible choisi. 1l s’agit de
fonctions logiques simples tel que porte ET, OU, flip-flop, latch, ...
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1.1.4 Quartus Il (version 7.2)

Ce logiciel effectue le placement-routage dans le circuit cible spécifique : il attribue des portions
(cellules) du circuit programmable aux fonctions identifiées lors de la synthese, planifie les intercon-
nections et génere le fichier de programmation (configuration) du circuit cible choisi.

Parmi ces outils, le placeur-routeur est le seul qui soit destiné spécifiquement & des circuits d’un
certain fabriquant. Il est fourni exclusivement par celui-ci, en I'occurrence la société Altera.

1.2 Exemple “Majorité”

Pour illustrer nos propos, nous allons créer tout au long de ce tutorial un projet simple, dont vous
pourrez reprendre les principes de construction pour les étendre a vos besoins.

Nous allons réaliser un systéme permettant de déterminer s’il y a une majorité sur trois votants.

. Majorite
Vote1
D>y Votel_ Majorite_top
> Vote2_i Maj_o P>
> Vote3d i

Generic Declarations

FIGURE 1.1 — Symbole du projet "Majorité” utilisé comme exemple

] Vote3 \ Vote2 \ Votel \ Maj \

0 0 0 0
0 0 1 0
0 1 0 0
0 1 1 1
1 0 0 0
1 0 1 1
1 1 0 1
1 1 1 1

TABLE 1.1 — Table de vérité

L’équation résultante, apres simplification :

Maj = Vote2 - Votel#Vote3 - Votel#Vote3 - Vote2

1.3 Etapes de conception

La conception d’un systeme passe par quatre étapes principales :

1. Réflexion et conception
2. Réalisation
3. Vérification

4. Intégration

La premiere étape sort du cadre de ce manuel. Elle fait partie du cours théorique de systeme numé-
rique. Les étapes suivantes seront présentées a ’aide de I’exemple. Elles nous permettront de passer
de la solution congue a une intégration dans un circuit.
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La deuxieme étape consiste a saisir votre solution dans le logiciel HDL Designer.

Pour la troisieme étape vous pourrez réaliser une simulation manuelle en appliquant des valeurs sur
les entrées et en vérifiant visuellement 1’état des sorties. Dans un deuxiéme temps, vous disposerez
d’un banc de test automatique pour une vérification complete de votre solution.

La derniere étape vous permettra de réaliser la traduction de votre schéma en vue de son intégration
dans un circuit logique programmable (CPLD ou FPGA). Il s’agit d’une syntheése suivie par le
placement-routage.

10



Présentation de HDL Designer

Ce chapitre donne les informations indispensable pour I'utilisation de HDL Designer.

11
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2.1 Organisation du répertoire d’un projet

Le répertoire d’un projet contient différents répertoires et fichiers décris ci-apres. Les projets que
nous allons réalisés contiennent toujours au minimum une bibliotheques :

— Bibliotheque de travail, pour la réalisation du travail demandé

Les bibliothéques de base, REDS_Lib_Base et REDS_Lib_IO, sont des bibliotheques partagées. Elles
sont toujours disponibles et se situent sur le disque C' :.

Dans le cas de projets plus important, il est possible d’avoir des bibliotheques supplémentaires.

Le nom du répertoire du projet est de la forme nomProjet_proj. Le sufixe _proj est obligatoire. Le
chemin d’acces a ce dermier doit correspondre a :

D :\ Classe\nom_groupe\ nomProjet_proj\

Dans ce répertoire se trouve :

— Les dossiers correspondants a chaque bibliotheque composant le projet. Chacun de ces répértoires
est constitué des dossiers décrits au paragraphe

— Le fichier nomProjet.hdp. 11 contient les chemins d’acces des différentes bibliotheques utilisées dans
le projet.

Remarque : Pour les noms des différents répertoires, il ne faut utiliser que les caractéres

non accentués (de ’A’ a °Z’) et “I’underline” (°_’). Il ne faut absolument pas utiliser

d’espace ou de signe tel que le ’&’!

ERE= L Frudiants (D)
. B Classe
; FJ ;‘I Mo _Groupe
=21 Majarite_proj
[—J;I Majorite
L H o Zamp
B araph
Clrr
- L wHDL
= ReDS _Lib_Base
=] Comp
&-[] Graph
-
1 svnth
1 vHOL

FIGURE 2.1 — Organisation d’un répertoire de travail

2.1.1 Structure du répértoire d’une bibliotheque
2.1.1.1 Répertoire “Comp”

Ce répertoire contient les fichiers de sortie du compilateur de ModelSim. Ces fichiers permettent de
simuler les différents modules du projet.

2.1.1.2 Répertoire “Graph”

Ce répertoire contient les données graphiques, créés par HDL Designer, servant a mémoriser les
différents symboles, graphes d’états, organigrammes, tables de vérité.

12
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2.1.1.3 Répertoire “P_R”

Ce répertoire contient les fichiers d’entrée et de sortie, pour chaque module, du logiciel de placement-
routage (logiciel Quartus IT).

2.1.1.4 Répertoire “Synth”

Ce répertoire contient les fichiers VHDL d’entrée et de sortie, pour chaque module, du logiciel de
synthese (logiciel Precision Synthesis).

2.1.1.5 Répertoire “VHDL"

Ce répertoire contient les fichiers sources VHDL (non graphiques) et les fichiers générés par HDL
Designer. Les fichiers générés sont la traduction, en VHDL, des différents objets graphiques se
trouvant dans le répertoire “Graph”. Ces fichiers seront compilés avec le compilateur de ModelSim
en vue de la simulation ou avec le compilateur “Generic 1 file” de HDL Designer en vue de la
synthese, généralement, avec Precision Synthesis.

2.2 Création d’un nouveau projet

Un projet est constitué d’un dossier ayant le nom [Nom_Projet]_proj contenant différents dossiers
et un fichier nommé [nom_projet].hdp. Dans le cadre du projet Majorité, le dossier projet se nomme
majorite_proj dans lequel on trouve le dossier majorite et le fichier Majorite.hdp.

2.2.1 Création du fichier nomProjet.hdp

La création d’un projet est automatisée a ’aide du script HDL_NewProject_MultiLibrary.tcl, dispo-
nible dans le menu : Démarrer > labo numérique > HDL_NewProject_MultiLibrary.tcl Cet utilitaire
permet de créer le fichier projet (*.hdp) utilisé par HDL Designer. Ce fichier contient le mapping
des différentes bibliotheques contenues dans le projet.

2.2.1.1 Utilisation de HDL_NewProject_MultiLibrary.tcl

1. Créer, s’il n’existe pas encore, le répertoire du projet (NomProjet_proj).
2. Lancer le script HDL_NewProject_MultiLibrary.tcl, la fenétre de la figure apparait.
3. Séléctionner le répertoire du projet a l'aide du bouton Choisir.
4. Ajouter les bibliotheques désirées, soit :
(a) Sous Bibliotheques standards, séléctionnez NomProjet pour créer une bibliotheque por-

tant le nom NomProjet. Un composant Top_Sim sera automatiquement inclu dans cette
bibliotheque (nous verrons plus tard son utilité).

(b) Si nécessaire sous Bibliothéques spécifiques, donnez le nom d’autres bibliotheques pour le
projet.

(¢) Les bibliotheques standards REDS_Lib_Base et REDS_Lib_IO sont automatiquement in-
tégrées.

13
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{ Creation de projet, version: 1.8 ;IEIEI

Création d'un projet HDL

Séléctionnez votre répertaire de travail

Chaizir | | D:/ClazzesMam_Groupet ajarite_praj

Mom du projet = Mom du dozsier zéléctionné. Dait finir par _proj

. Bibliothéques spécifiques
Bibliothéques standards —

v MHorn projet; baze pour les étudiants
avec Top_Sim inciu

Lire fichier | Generer |

FIGURE 2.2 — Fenétre de création d’un nouveau projet

Cet utilitaire crée le fichier NomProjet.hdp contenant le mapping des différentes bibliotheques. Il
crée aussi les répertoires des différentes bibliotheques en y incluant les répertoires P_R et Graph.

Les autres répertoires soit Comp, Synth et VHDL seront créés automatiquement par HDL Designer
lors de I'utilisation des Tasks, par exemple le répertoire Comp sera créé lors de la premiere utilisation
du Task Compile.

2.2.2 Ajout d’une bibliotheque a projet existant

1. Lancer le script HDL_NewProject_MultiLibrary.tcl, la fenétre de la figure apparait.
2. Séléctionner le répertoire du projet a I’aide du bouton choisir.
3. Relecture du fichier projet en cliquant sur le bouton Lire fichier.
4. Ajouter les bibliotheques désirées a celle déja disponible, soit :
(a) Sous Bibliothéques standards, séléctionnez NomProjet pour créer une bibliothéque portant
le nom NomProjet.

ous Bibliothéques spécifiques, donnez le nom d’autres bibliotheques pour le projet.
b) Sous Bibliothé ¢l d 1 d’autres bibliothe 1 jet

14
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2.3 Lancement de HDL Designer et ouverture du projet

Un projet est en général soit fourni par votre professeur (en général a Padresse \\ eint20\ reds\labo\...)
soit une sauvegarde personelle d’un projet en cours. Copier les sources de votre projet, le
répertoire [nom_projet]_proj, dans votre répertoire de travail (D :\classe\groupe\).

Dans le cas du projet Majorité, il faut copier le dossier Majorite_proj complet a Uadresse D :\ classe\ groupe\

2.3.1 Lancement du programme

Pour lancer le programme HDL Designer, allez dans :
Demarrer > Labo Numerique > EDA > HDL Designer 2007.1

Une fois HDL Designer lancé, vous vous trouvez dans le Projet Manager comme montre a la figure
2.5l

HBDesign Manager - Project Bibliotheque_base

Project roject Manager (2] )| Tasks
. New My Project: CAED&MT ools_REDS'HDLDesigner\Bibliotheque_base\Bibliotheque_base.hdp ¥ My Tasks

Project... Shared Project: $HDS_TEAM_HOME'\shared.hdp @; Generate
. Open ¥ _Regular Libraries [ 2 items ] n # Compile
" Project.. ® s reds_lib_base M Simulate

% New B reds_lib_0
™" Library... Protected Libraries [ 5 items
Downstream Only Libraries [ Empty |

Bf% concatenation
g Synthesis
Team Tasks

Edit
& \appings..

FIGURE 2.3 — Design Manager suite au lancement de HDL Designer

2.3.2 Chargement d’un projet

Opérations a suivre pour charger un projet :

Bouton Open Projet (partie de gauche du Design Manager)

— Dans la fenétre qui apparait, bouton Browse

Sélectionner le fichier nom_du_projet.hdp situé dans le répertoire [Nom_Projet|_proj (dans le cas
du projet Majorité, le chemin est D :\ Classe\ Groupe\ Majorite_proj\majorite.hdp) et cliquez sur
Ouwrir

Cliquez sur OK

HDL Designer ouvre le projet et vous devriez vous trouvez dans une situation similaire a la figure
La bibliotheque Majorité a été ouverte automatiquement.

Dans le Projet Manager, on voit les bibliotheques disponibles dans le projet.
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File Edit Yiew HOL Tasks Tools ©ptions Window Help

H}Design Manager - Project Majorite

Flle Edit Yiew HDL Tasks Tools

Options Window  Help

I [

EEEr

|8 - =&

plrEex &z 2w

| & 2 w|ED - & 8D a [T
o2l Lo
Design Uinis 2 My Tasks =] Shared Project. $HDS_TEAM_HOME sh
£l (L) Majorte . 4 Generate +_Regular Libraries [ 3 items
V8] Maioits_top % Compile =®  Majorite <active>
B Majorite_top_th Simul )
s Simulate - 9§ ReD5_ib_Pase
5 Majorite_top_tester
8 Top_Sim B® concatenation = g reds b0
Syrthesis Protected Libraries [ 5 items
O Team Tasks b Downstream Only Libraries | Empty
Flow - Single . R R .
4 Lancement: de Precision
RPN oo Start Precision JMI bhOtheque dlsponlble
r— ERE dans le projet
& Majoits -
Tasks -

Ready

(a) situation lors de l'ouveture d'un projet
(c) onglet de navigation entre
projet browser et les bibliothéque

FIGURE 2.4 — Ouverture du projet Majorité (bibliotheque vide)

Pour la réalisation et la simulation de projet, le REDS met a disposition deux bibliotheques :

— REDS_Lib_Base
— REDS_Lib_IO

Celles-ci seront détaillées par la suite au travers d’exemples.
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2. Présentation de HDL Designer Version du 27 aout 08

2.4 Création du composant top

Lors d’une description hiérarchique, le composant de niveau le plus haut se nomme toujours nom-
Projet_top (dans notre example majorite_top).

2.4.1 Création du symbol top

Allez dans la barre verticale a gauche de ’écran et sélectionnez dans 'onglet “Main” > “New/Add”.
La fenétre de la figure [3.1| apparait.

Design Unit [Type |Extends |Language
HOL = LY Maiorite:
= 78 Top_Sim Campanent

WHOL

"4 Design Content Creation Wizard - Specify Conte
Q Cateqones Fie Types:

o <hudd Existing HDL Diesign ta Frojects
—_ <Add Existing Files to Librarys

B2 Black Disgram

: &l BD
AN YHDL Fil K Wy cois i
Veiilog File 2 Flow Chatt
Simulate Test File 2 B asu
B Truth Table

Docurnert &
Visuslize

[Thie Intait=os view defines the signsl Interfacs of a component 5nd s representation when
Instartiated on = block diagiam

2]

& VHOL € Verlog %5

€ Vsrilog 2005 Propeties

=121

4

Nea> | Fish | cancel | Hen |

=

FIGURE 2.5 — Création d’un nouveau symbole

Sélectionnez > “Graphical View” > “Interface” > “Next>". La fenétre de la figure [3.2] apparait.

"4 Design Content Creation Wizard - Specify View x|
Creating document: Interface

You can specify where you want your file to be placed.
File
Library name:

[Majorte

Design Unit name:
(Entity name)

Lol L«

[Wajorte _top

Yiew name;
[Brchitecture name)

[symbol sb

FIGURE 2.6 — Définition du nom du symbole

Lors de I'enregistement d’un symbole, il faut spécifier la librairie dans laquelle fait partie ce compo-
sant (dans le champ Library name).

Le symbole enregistré étant le composant principal du projet (le top), il faut lui donner comme
nom (dans le champ Design Unit Name) le nom du projet avec I’adjonction du suffixe ”_Top” ce

qui donne, dans notre exemple Majorite_Top. Puis cliquez sur Finish. La fenétre symbol(Interface)
(figure fenétre du haut) s’ouvre.
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%4 Majorite/Majorite_top/symbol * (Interface E =ioix]
Fie Fot View HDL Toble Tasks Agd Optiens Vandow Help

B e+ BS- BB - AF |- V-B-Y-
[»roo bt + 750 00% A

a 1 2 Py a
Y Wroup |  Neme  (Meh | Tew | Gowd |
l.
Saisie des 1/0
a8 Onglets
- Interface - Symbol
Navigation
S
[E A TR T ===
Rest Uuuw‘mun:pt—:nSﬁblca

Majorite /Majorite_top/symbol * (Symbol

Fie Edit View HDL Dagram Tasks Add Ogtions Window Meip
EBo s ARBR AR s u== =K

Decions B s 1l
Pocts: §‘
vser: -
i oo £
L Declarations 5‘
P| Packsge List H
H
cite
tapres iz Coetert A
PR
- -
What do you want to
leam about?

o Toson Disgem
Nevgahon
> o Defrivgte imetace
» TN
[HE e = 1] T I S O Ll N S

FIGURE 2.7 — Création/Edition d’un symbole

Deux méthodes de saisie des entrées/sorties sont disponibles. La premiére est textuelle et la seconde
est graphique et permet de placer les entrées/sorites autour du symbole.

On remarque dans ces fenétres les différents points importants (cf. figure :

— Les outils indispensables
— Les deux onglets Interface et Symbol

2.4.1.1 Ouitils indispensables

L’outil de sélection

Loutil d’ajout de commentaires

L’outil d’ajout de port d’entrée a ’entité
L’outil d’ajout de port de sortie & 'entité
L’outil d’ajout de port d’entrée/sortie & l'entité

o V| | B &

TABLE 2.1 — Outils indispensables

2.4.1.2 Ajout de port

Pour ajouter des "ports”, dans la vue graphique Symbol(Symbol), sélectionnez un des outils d’ajout
(entrée, sortie, ... ) puis ajouter autant de signaux que nécessaire en cliquant sur les bords du symbole
a 'endroit souhaité. Pour revenir a I'outil de sélection, il suffit de cliquer avec le bouton droit de la

souris ou appuyer sur la touche ESC.
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2. Présentation de HDL Designer Version du 27 aout 08

2.4.1.3 Définition des propriétés de chaque "port”

Pour définir les propriétés des ports; soit son nom, son type ainsi que la taille, allez dans 1'onglet
Interface ou faire un double-clic sur un triangle représentant un port. Dans la fenétre qui apparait,
entrez les valeurs afin d’obtenir le méme résultat que celui de la fenétre de la figure

"4 Majorite/Majorite_top/symbol * (Generics) =1
File Edit View HDL Table Tasks Add Options Window Help

[@-¢»2HE80 - 2@ - W& | -7 -8-4-
[>>0 0 mze~vuszotla

A 5 c D 3 F 3 1]
@) Greve Name Mods Type Bounds Intial Comment L Interface
3 Symbol
1 Veter n std_egic &} Generics
: 3

P] Package List

| 12smo1g wesbeig|

Content
[CRSN AN

What do you want to
lean about?

« Tips on Diagram
Navigation
« Defining the Inteiface

|2-4-2-|A ~ B Z U=

|Design “Majorte/Majorte_top/struct” saved successfully.

il
Ll

FIGURE 2.8 — Définition des propriétés des ports du composant pour le projet "Majorité”

2.4.2 Création du schéma du top

Pour la création du schéma du top :

— Faite un double-clic sur le composant créé au point précédent. La fenétre de la figure [2.9| apparait

") Open Down Create New View - Specify Type: x|

Categores: Fle Types:

VHDL File
Text File

& Book Diagram
onnected by signas, buses or bundies.

FIGURE 2.9 — Fenétre de choix du type de schéma (architecture) d’un composant
— Sélectionnez Graphical View > Bloc Diagram et cliquez sur le bouton Next >

— Dans la nouvelle fenétre, validez avec le bouton Finish

— Vous vous retrouvez dans la méme situation que montrée a la figure 2.10] On retrouve les signaux
créés au point précédent

19



REDS - HEIG-VD Outils d’aide a la conception de circuits numériques

ite/Majorite_top/struct * {Block Diagram) -0 5[
File Edit Wew HDL Diagram Tasks Sipulation Add  Options  Window OLE  Help

|- ¢«2aH3DL 2B -~ R P2PAL|B ru===A,
[k -A®[s-XE8BMWE G- L-.-%-~-0 0@ &E-
&
. PackageL.ist o P o . .
~LIBRARYieee; ~  gEEERNSL
. USE ieee.std_logic_1164.ALL; = Votel i @ std_logic - -
USE ieee.numeric_std.ALL; froteZ_i ¢ std legic]
] o Wote3d i : std logic

o Maj_o . std_legic |
. Diagram Signals: . . o

Votel | E— O

\;Ofeg;i:

Votég;ii:

= Ol (L

FIGURE 2.10 — Situation suite a la création d’un schéma
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2. Présentation de HDL Designer Version du 27 aout 08

2.5 Sauvegarde d’un projet

Le disque dur local “D :” peut étre effacé d’une séance a ’autre sans préavis!
A la fin de chaque séance, chaque groupe doit faire une copie du dossier contenant le projet sur son
compte personnel (qui se trouve généralement sous le lecteur réseau “T :” et sur un autre support

(clé USB, ou autres).

Chaque groupe doit disposer d’au minimum 3 sauvegardes. Chaque étudiant doit avoir
accés a au moins une copie du projet.

De par la limitation en taille des comptes personnels a la HEIG-VD, il est souvent nécessaire de ne
garder que le minimum d’information utile afin de pouvoir sauvegarder tous les travaux de laboratoire

€n cours.

En ce qui concerne le laboratoire de systemes numériques, il est possible d’alléger la taille des données
a sauvegarder en supprimant les sous-dossier du projet suivants :

— Dans le dossier des blibliotheques qui se trouve a l'intérieur du dossier projet :
— Comp

— Synth

- PR

La suppression de ces dossiers nécessitera d’effectuer, a nouveau, les opérations suivantes :

1. Création du répértoire P_R dans les dossiers des bilibotheques
2. Génération des descriptions VHDL
3. Compilation des descriptions VHDL

4. Synthese Placement-routage

Si la place sur votre compte personnel le permet, il est conseillé de ne pas supprimer les répertoires
synth et P_R. Vous supprimez uniquement le répertoire Comp.

2.6 Saisie de schémas, description du projet

2.6.1 Ouverture du schéma du top

Pour ouvrir le composant *_top (dans notre exemple Majorite_top) :

1. Sélectionnez la bibliotheque de travail a 1’aide des onglets
2. Double-cliquez le composant (dans notre exemple Majorite_top)

3. Le composant s’ouvre dans une nouvelle fenétre (affichage de son architecture)
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2.6.2 Saisie d’'un schéma

2.6.2.1 Outils indispensables

L’outil d’ajout de blocs

L’outil d’ajout de composants

L’outil d’ajout d’expressions concurrentes

L’outil d’ajout de signaux a un élément

L’outil d’ajout de vecteurs (signaux multi-éléments)

> P P o ||

L’outil d’ajout de commentaires

TABLE 2.2 — Outils indispensables

2.6.2.2 Importation de composant de REDS_Lib_Base

Pour notre projet Majorité, nous avons besoin de trois portes AND2, une porte OR4 et un GND.
Tous ces composants sont disponibles dans REDS_Lib_Base.

Pour les inclure dans notre schéma :

1. Ouvrir la fenétre Componant Browser en utilisant 1'outil d’ajout de composants ( I, Add
component).

2. Dans la nouvelle fenétre, sélectionnez la bibliotheque REDS_Lib_Base comme montré a la
figure 2.10]

3. Glissez-Déposez les composants nécessaires dans votre schéma

Ajout d’une bibliotheque Sélection de la bibliothéque Composants disponibles
x| " Exnlors 1ibrary x| "d Component Brow'ier x|
= REDS Lib Base ) @;{_@Jﬁ] EI _zj 2
£ O flexiOke | = ) Majorite =
(- 78] Maiorite_top s - (B Majorite_top
- 18| Top_Sim g - (B Top_Sim
1 “‘

O modulewars

- -

| m BasculeRS_#Asynch

DK Cancel & (B Camnl
To-instance & component, drsg onta & diagram, oruse d To instancs @ component -drag onto a disgram. or uss _!
Copy and Pastes Copy and Faste
= =,
(a) fenétre par défaut (b) séléction de ReDS _lib_base (c) liste des composants disponibles

FIGURE 2.11 — Sélection de la bibliotheque ReDS_lib_base

2.6.2.3 Interconnexion

Les interconnexions se font tres facilement avec 'outil Ajout de signal ou Ajout de vecteur. Un
vecteur sera utilisé pour interconnecter des éléments ayants un port de plusieurs bits de large, alors
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qu’un signal sert a interconnecter un port d’un seul bit. En pointant directement sur les ports des
éléments, les vecteurs prennent directement le bon nombre de bits.

Les signaux prennent les noms des entrées/sorties (ports*) sur lesquelles nous les avons connectés
en premier. Pour changer ce nom, on peut double-cliquer sur le signal et le changer dans la boite de
dialogue qui apparait sous I’étiquette Name. Par convention, tous les signaux internes a un composant
prennent le suffixe : “_s”. On peut “couder” un signal en cliquant une fois sur son trajet.

*N.B. : dans la suite de ce manuel, on utilisera le terme anglais port pour désigner indifféremment
une entrée ou une sortie.

2.6.2.4 Schéma bloc résultant

Apres 'importation et 'interconnexion, nous obtenons le schéma de la figure [2.12

Votel_i I—@——— >
Vote2_i I >

>
Vote3_i I >
Vote2_i B
Vote3_i
—

Vote13_s

Maj_o

FIGURE 2.12 — Schéma bloc du projet Majorité

2.6.3 Exportation du schéma réalisé

Afin d’agrémenter votre rapport de jolies illustrations, il est possible de coller le schéma directement
dans Word ou un autre logiciel utilisant la technologie OLE. Tout objet graphique peut-étre exporté
en effectuant un cliquer-déplacer de la barre bleue qui se trouve & gauche de la fenétre vers la fenétre
du document de réception.

2.6.4 Impression

HDL Designer permet d’agencer directement la mise en page de toute la conception. Vous pou-
vez définir le nombre de pages sur lesquelles le document sera imprimé, HDL Designer mettra les
éléments a la bonne échelle.

En allant dans le menu File choisissez Page Setup... Dans cette fenétre I'option Fit to permet de
spécifier le nombre de pages. L'option Show Header and Footer permet de faire figurer la date,
I’auteur et le chemin du fichier.

2.7 Concaténation et explosion de vecteurs

Pour 'utilisation de certains composants, il sera nécessaire de regrouper des signaux en vecteurs ou
d’exploser un vecteur en plusieurs signaux.

Cette explication sera utilisée dans le cas ou le projet fourni contient un vecteur en entrée ou en
sortie.

Pour illustrer la marche a suivre, nous allons utiliser un multiplexeur d’un bus de 2 bits avec 2
muliplexeurs 2tol (disponible dans la bibliotheque REDS_Lib_Base).
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HI} Majorite/MuxZtol_2bits/struct (Block Diagram} (=] 5|
Fle Edt Wew HDL Diagram Tasks Simulstion Add Options Window OLE Help

B-«2EHEDER-=nFPLLL[n s u===& ]
k-A® ¥EBBRMEEE- L -L-5-=-008 &%
T o
0} G 01
En
ul I
1 D
Mo el
1] S v
T o
B (Beld oy eon D
En -
0 b
il
Mux_2tat

- 2ra-Fr == are o\ =
B =

Design “Maiore/Mus2tol_Zhits/stnuct” saved successhully

FIGURE 2.13 — Multiplexeur 2tol avec vecteurs de 2 bits

2.7.1 Connexion d’une partie d’un vecteur

Nous allons extraire des signaux aux vecteurs et vice-versa :

1. Sélectionnez 'outil Ajout de signal
2. Rattachez-le au port de la porte qui vous intéresse

3. Allongez le pour le connecter au vecteur.

Lors de la connexion, HDL Designer va ouvrir une boite de dialogue qui vous permettra de choisir
I'indice du signal correspondant dans le vecteur. Le signal prendra le nom du vecteur ainsi que
I'indice du bit qu’il représente entre parenthese.

Specify bus element to rip:
Bus: Vote_i: std_logic_vector{ 2 DOWNTO 0]

Specify Element: |EI ﬂ I L‘ I LI
DK I Cancel I Help

HQRip Element From Bus i x|
|

7

1N

FIGURE 2.14 — Fenétre de "extraction” de signaux

Si vous vous étes trompés, la méthode de correction la plus simple consiste a effacer le signal erroné
et a refaire 'opération. Si cette méthode ne vous convient pas, vous pouvez ouvrir les propriétés
du signal incriminé et les modifier en donnant le méme nom que le vecteur (que HDL Designer va
reconnaitre) et compléter le champ Slice/Index avec I'index du bit qui vous intéresse. La figure [2.15)
illustre le résultat obtenu.

Pour regrouper des sorties distinctes en un vecteur, on procédera de la méme maniere, sauf qu’il
faudra connecter d’abord le signal au vecteur et ensuite le connecter au port.
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HMajorite/Mux2tol_2bits/struct (Block Diagram)

=iaix
File Edt View HDL Diagram Tasks Simulation Add Options ‘Window OLE  Help
B -esBEHSR . =0 - BESL LS|
B 7 U|= | & &
h-AD 2 E®SHMA

Lon-nee -of08)sY-
MUK =
Sel i M————————— GO
e En
no_icty o v _ot)
n1_i(1) 4
n0_i T_20oT
1] Mo
MU
»—
nt (el on
En_i En
n0_i{0) N v oy I
n1_if) 4
M _Zto1
i

|- A=k
[E-m - S 2t 5 )

Design "M ajorite Muk2to]_2bits/struct” saved successiully.

FI1GURE 2.15 — Résultat du multiplexeur une fois les connexions effectuées
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Utilisation de HDL Designer

Ce chapitre donne une description de la mise en oeuvre des fonctions que propose HDL Designer.
Pour obtenir les informations concernant 1'utilisation de HDL Designer dans le flow de conception,
veuillez vous référer au chapitre 2, “Présentation de HDL Designer”.

3.1 Création d’'un nouveau symbole

Allez dans la barre verticale & gauche de I’écran et sélectionnez dans 'onglet “Main” > “New/Add”.
La fenétre de la figure [B.I] apparait.

‘\w Design Manager - Project Majorite

I

le  Edit Wiew L Tasks Topls Options Window Help

Design Explorer [ Using viewpoint - Default Viewpoint [Filtered) - Don

Design Unit [Type |[Extends |Language
= LY Maioiite
7B Top_Sim Component WHDL

<tdd Existing HDL Design to Project>

<i1dd Existing Files to Librar> B2 Block Diagram

G &l BD

YHDL File %3 State Diagram

Veiilog File &, Flow Chatt

Text File 2 B asu

B Truth Table

The Interfacs view defines the signal f a comp: and when
Instantisted on.a black diagram

=

= |

+ VKDL © Verlog '95  Veriog 2005 Fropsiies
4

Net> | Fsh | cecel | ben |

=

F1GURE 3.1 — Création d’un nouveau symbole

Sélectionnez > “Graphical View” > “Interface”. La fenétre de la figure [3.2] apparait.

g Design Content Creation Wizard - Specify View Namesk]|

Creating document; rterface.
You can speciy where you wan yourfil to be placed.

Lbrayname: [ieerte

Design Untrame:  [Fiaom -
ey [Majorte_top =]

[rymbolsb

View e
{puchitecture rame)

FI1GURE 3.2 — Définition du nom du symbole
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Version du 27 aout 08

Lors de I'enregistement d’un symbole, il faut spécifier la librairie dans laquelle fait partie ce compo-

sant (dans le champ Library name).

Si le symbole enregistré est le composant principal du projet (le top), il faut lui donner comme
nom (dans le champ Design Unit) le nom du projet avec 'adjonction du suffixe _top ce qui donne,
dans notre exemple monProjet_top. Puis cliquez sur Finish. La fenétre symbol(Interface) (figure (3.3

fenétre du haut) s’ouvre.

4 Majorite/Majorite_top/symbol * (Interface ] =loix]
Fie FOt View DL Toble Tasks Acd Optiens VWndow Help

B e+ BB B - AF|E-N-B-Y-
>0t Mt 7 HAHSS|M

e S = ~ z z Fa— o
B Soee | teme uede Tros Gy S | Covimid | ntnlace) g
| ‘ ” } \

Saisie des I/0 ] Package L

T

What do you want to
Jearn sbout?

* Tor on Disgam
Navgehn
« Delrng e Irtedace

|&-4 -7

.~ outilsindispensables

bo
Fe Edit View HDL Dagram Tasks Add Ostons Window Msip
(R B3l "B e ARPLAB||s == =K.

Outils OLICEER BB .
indispensables -

"L Decluations
P| Package List

[savvonn umsoea[pm

TR
What do you want to
leam about?
o Vs on Disgam
>l ¢ Defrnng e indedace
) N

i |
L A el e ] ™ || | e W o ot
Resdy

FIGURE 3.3 — Création/Edition d’un symbole

Interface - Symbol

Deux méthodes de saisie des entrées/sorites sont disponibles. La premiere est textuelle et la seconde

est graphique et permet de placer les entrées/sorites autour du symbole.

On remarque dans ces fenétres les différents points importants (cf. figure [3.3)) :

— Les outils indispensables
— Les deux onglets Interface et Symbol

3.1.0.1 Outils indispensables

L’outil de sélection

Loutil d’ajout de commentaires

L’outil d’ajout de port d’entrée a I'entité

L’outil d’ajout de port de sortie a I’entité

O Y| w| >| &

L’outil d’ajout de port d’entrée/sortie & 'entité

TABLE 3.1 — Outils indispensables
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3.1.0.2 Ajout de port

Pour ajouter des "ports”, dans la vue graphique Symbol(Symbol), sélectionnez un des outils d’ajout
(entrée, sortie, ... ) puis ajouter autant de signaux que nécessaire en cliquant sur les bords du symbole
a I’endroit souhaité. Pour revenir a l'outil de sélection, il suffit de cliquer avec le bouton droit de la
souris ou appuyer sur la touche ESC.

3.1.0.3 Définition des propriétés de chaque "port”

Pour définir les propriétés des ports; soit son nom, son type ainsi que la taille, allez dans 1’onglet
Interface ou faire un double-clic sur un triangle représentant un port. Dans la fenétre qui apparait,
entrez les valeurs afin d’obtenir le méme résultat que celui de la fenétre de la figure [3.4]

SI=TF

File Edit View HDL Table Tasks Add Options Window Help

LB @o M-8 -0

= 7% 0 ena
0 :

[2-es>a8

Tyee Bounds Intsl | Comment

|2-4-8 KA~ ® 2 u|=

oesn Wit/ op/sut” savedsacoos

FIGURE 3.4 — Définition des propriétés des ports du composant

Les propriétés :

— Nom
— Nom du signal. Selon la convention définie au ReDS le nom doit commencer par une majuscule.
Il doit aussi avoir un suffixe définissant le "sens” du port, soit :
— *_i pour les entrées
— *_o pour les sorties
— *_io pour les signaux bi-directionnelles
— Mode
— Définition du "sens” du "port” (in, out ou inout). Le mode buffer n’est pas utilisé au ReDS
— Type
— Permet de définir le type du port, soit Std_Logic ou Std_Logic_Vector (les autres types ne sont
pas utilisés dans les entités/symboles)
— Bounds
— Permet de définir la taille d’un vecteur (nombre de bits)
— Comment
— Ajout un commantaire définissant le signal

3.2 Création d'une architecture

HDL Designer permet la création d’un certain nombre de types d’architectures différentes. Il permet
aussi de créer/gérer plusieurs architectures pour un symbole donné.

3.2.1 Création d’une nouvelle architecture

Effectuez un double-clic sur le symbole créé au point précédent. Le dialogue de la figure[3.5] apparait.
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" Open Down Create New View - Specify | x|
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FIGURE 3.5 — Dialogue pour la création d’une nouvelle architecture

Si vous désirez créer une achitecture de type :

— Structurelle
— Sélectionner ”Bloc Diagram” et cliquez avec le bouton Next> Dans la nouvelle fenétre, validez
avec le bouton Finish (utilisation du nom par défaut) Suivre les instructions du § “Création
d’un vue structurelle”
— Textuelle en VHDL
— Sélectionner ”Architecture” et cliquez avec le bouton Next> Dans la nouvelle fenétre, donnez
un nom a cette architecture sous Architecture : Validez avec le bouton Finish, le fichier VHDL
s’ouvre automatiquement
— Machine d’état graphique
— Sélectionner ”State Diagram” et cliquez avec le bouton Nezt> Dans la nouvelle fenétre, validez
avec le bouton Finish (utilisation du nom par défaut) Suivre les instructions du § [3.5] “Création
de machine d’état”

Remarque : Les autres types d’architecture ne sont pas utilisés dans le cadre de I'institut ReDS.

3.2.2 Création d’une deuxiéme (ou plus) architecture

— Depuis le "Design Explorer”; faite un clic-droite sur le composant auquel vous désirez ajouter une
architecture
— Cliquez sur New puis choisissez I'architecture souhaitée en vous déplacant dans le menu contextuel.
Exemples :
— Architecture Structurelle
— New > Graphical View > Bloc Diagram...
— Textuelle
— New > VHDL View > VHDL Combined...
— Machine d’état
— New > Graphical View > State Diagram...

Dans la fenétre qui apparait, donnez un nom a la vue ainsi créée et validez avec le bouton Finish ou
OK.

3.2.3 Gestion des architectures

Il est nécessaire d’indiquer I'architecture utilisée lorsqu’il y en a plusieurs. Un seule architecture est
utilisée par entité. L’architecture utilisée (par défaut) pour une entité est illustrée par un triangle
bleu & la gauche de celle-ci (cf. figure [3.6]).

Pour changer I'architecture utilisée :

— Clic-droite sur 'architecture que vous voulez utiliser.
— Dans le menu contextuel, choisir 'option “Set Default View”.
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FIGURE 3.6 — Architecture/vue par defaut

3.3 Utilisation d’architectures multiples

11 est possible d’avoir plusieurs schémas (architectures) pour un méme composant, exemple avec un
multiplexeur 2 vers 1. Ce dernier a trois architectures (cf. figure|3.7)) :

— Schéma avec des portes logiques de base.
— Schéma avec des portes NAND2.
— Description textuelle VHDL.

i Design Manager - Project exemple
File Edit Wew HDL Tasks Tools Options SwWindow Help

ENIEX Y Eil
|2 2 dE- &8 RB|ER 2 &

|52 % -

E Design Explorer 2l =l Tasks 2|« x|
- Drezign Units: ¥ My Tasks A~
[ | - @ B Gene—
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e B st _NAND2 = [ Tasks |
< [ symbol Downstrear 2 | 4] x|
: VB Mus_2tal_th A Wanip
[ a Pfun_2to1_tester
= v
7. | 3l > T ¥
e TTL | Majorite m
Loading Library majorite complete 4

FIGURE 3.7 — Visualisation des architectures disponibles pour le composants Mux_2tol

Les figures suivantes montrent les schémas réalisés avec des portes logiques de base (figure [3.8)) et
réalisé avec des portes NAND2 (figure [3.9).
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USE ieee.std_logic_1164 ALL;
USE ieee.numeric_std ALL

FIGURE 3.9 — Schéma réalisé avec des portes logiques de type NAND2

3.4

Création d’une vue structurelle

3.4.1 Outils indispensables
B | 444 Block L'outil d’ajout de blocs
B | Ada Component L’outil d’ajout de composants
E Add Embedded Block | L’outil d’ajout d’expressions concurrentes
L | Add Signal L’outil d’ajout de signaux a un élément
L | Add Bus L’outil d’ajout de vecteurs (signaux multi-éléments)
A Text L’outil d’ajout de commentaires

TABLE 3.2 — Outils indispensables

3.4.2 Ajout d’expressions concurrentes

Apres avoir ajouté une expression concurrente, il faut effectuer un double-clic sur le bloc la repré-

sentant ; cette action aura comme effet d’afficher le dialogue suivant :
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x|
Create a new view for. Embedded Block: ebl
Select type of view to create:
& Text
" State Diagram
€ Flow Chart
€ ASM
€ Trth Table
Cancel J,

FI1GURE 3.10 — Dialogue de création d’une expression concurrente

Choisir le type “Text”. Seules les instructions concurrentes de type Text sont intéressantes (et utili-
sées) dans le cadre du laboratoire de systémes numériques!

— EO Exemple_1 S0 —
S]
S0 <=not EO;
- E1 Exemple_2 S1 .
2
S1<=notE1;
» E2 0 )
- E2 1 Exemple_3 $2:(2:0) .
1
» E2 2 )

‘sz <=E2 28&E2 18E2.0; \

FI1GURE 3.11 — Exemples d’instructions concurrentes

3.4.3 Différence entre les blocs et les composants

Il y a trois différences majeures entre un bloc et un composant :

— Le bloc permet d’avoir une approche de conception “Top-Down” (de haut en bas) tandis que le
composant permet d’avoir une approche de conception “Bottom-Up” (de bas en haut).

— Une fois la décomposition finie, la conversion d’un bloc en un composant se fait facilement, 'inverse
est impossible.

— Le bloc ne peut étre instancié qu’a un seul et unique endroit. Par contre un composant peut étre
instancié un nombre quelconque de fois.

3.4.4 Remarque sur le terme “bus”

La société MentorGraphics a fait un abus de langage en utilisant le terme bus pour désigner un
vecteur, soit un signal (au sens VHDL) composé de plusieurs éléments. Lorsqu’on lit le terme “bus”
dans “HDL Designer”, il faut I'interpréter comme un vecteur.

Pour changer le nom des signaux internes, il suffit d’effectuer un double-clic sur la connexion repré-
sentant le signal.

Pour donner le nom au bloc, il suffit d’effectuer un double-clic sur le texte “<block>" et d’introduire
le nom voulu a la place.

3.4.5 Style des connexions

Il est possible de différencier, graphiquement, les vecteurs des signaux a un seul élément en fonction
de la largeur du trait représentant la connexion.
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Pour les signaux & un seul élément il faut utiliser le style “Signal” et pour les vecteurs de signal il
faut utiliser le style “Bus”!

3.5 Création de machine d’état

HDL Designer permet de faire la création de machine d’état sous forme graphique.

3.5.1 Outils indispensables

@ | L’outil d’ajout d’états.

* | L’outil d’ajout de transitions entre deux états.

A | Loutil d’ajout de commentaires.

TABLE 3.3 — Outils indispensables

3.5.2 Signification des différents symboles d’un graphe Etat

Etat initial. La machine d’états est mise dans cet état lors d’un reset. Il ne peut
y avoir qu’un état initial par graphe d’états.

Un des états du graphe d’états Chaque état peut devenir I’état initial en cochant
la casse "Start state” dans les propriétés de 1’état.

TABLE 3.4 — Outils indispensables

3.5.2.1 Transition

Dans le menu contextuel, il est possible d’ajouter ou de supprimer des points de controéle (définissant
le tracé de la transition) a 'aide des commandes “Add Route” et “Remove Route”. 1l est également
possible de changer le sens de la transition a ’aide de la commande Reverse Direction.

3.5.2.2 Condition de transition

Elle est contenue dans un rectangle en surimpression de la transition.
L’expression de la condition doit étre écrite en VHDL.

Pour chaque état, il ne peut y avoir, partant de cet état, qu'une seule transition n’ayant aucune
condition spécifiée. Cette transition sera effectuée par défaut lorsque aucune autre des conditions
des transitions partant de cet état n’est satisfaite.

Si toutes les transitions partant d’un état ont une condition définie, une transition sans condition
sera définie de maniere implicite par le logiciel HDL Designer afin de maintenir I’état courant dans
le cas ou aucune des conditions ne serait satisfaite.

3.5.2.3 Numéro de priorité (pour les transitions)

Ce numéro est contenu dans un cercle en surimpression de la transition. Il devient visible des qu’il
y a plus d’une transition partant depuis un état.
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Il indique l'ordre dans lequel I’évaluation des conditions de transition & partir d’un état doit étre
faite. Ce numéro permet de simplifier '’expression d’une condition de transition. Il sous-entend que
cette condition n’est prise en compte que lorsque celles portant un numéro plus petit ne sont pas
satisfaites. L’ordre d’évaluation des conditions peut étre changé dans le dialogue des propriétés des
transitions.

3.5.2.4 Action sur les sorties de type Moore

Pour définir une action sur les sorties de type Moore, il faut double-cliquer sur ’état auquel on veut
associer l'action. Celle-ci doit étre écrite en VHDL. Les actions sur les sorties sont affichées a coté
des états. Usuellement, les actions sont déplacées afin d’étre positionnées dans I'état auquel elles
se rapportent. Action sur les sorties de type Mealy Pour définir une action sur les sorties de type
Mealy, il faut double-cliquer sur la transition a laquelle on veut associer I'action. Celle-ci doit étre
écrite en VHDL. Les actions sur les sorties sont affichées dans le méme rectangle que la condition de
transition, dont elles sont séparées par une ligne (les conditions apparaissent au dessus et les actions
au-dessous de cette ligne).

Les actions sur les sorties de type Mealy peuvent également étre spécifiées dans les états comme
pour les sorties de type Moore. Ces actions contiennent, dans ce cas, une affectation conditionnelle
permettant de définir la valeur des sorties selon une combinaison des entrées.

3.5.3 Propriétés essentielles d’un graphe d’états

Les propriétés d’'un graphe d’états se trouvent dans les menus “Edit > Object Properties...” et
“Diagram > State Machine Properties...”.

3.6.3.1 La fenétre “Object Properties”

Cettre fenétre vous permet de définir les parameétres essentiels de la machine d’état tel :

— le signal a utiliser pour I’horloge ainsi que le flanc de déclenchement.
— le signal & utiliser pour le reset, son niveau d’activation ainsi que son mode (reset synchrone ou
asynchrone).

3.5.4 Autres propriétés d’'un graphe d’états

Les propriétés d’un graphe d’états se trouvent dans les menus “Diagram > State Machine Proper-
ties...”.

3.5.4.1 Generation

Dans cet onglet on peut spécifier :

— si ’on veut une machine d’états synchrone ou asynchrone. Dans le cadre des laboratoires, on utilise
uniquement des machines d’états synchrones.

— le nom des signaux internes représentent ’état présent et I’état futur. Si les deux champs corres-
pondants sont vides, des noms par défaut (current_state et next_state) sont utilisés. L’intérét, de
spécifier des noms a ces signaux, est de pouvoir effectuer des affectations sur les sorties & partir
de bits d’états.
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3.5.4.2 Encoding

Permet de spécifier la maniere dont il faut coder les états. En choisissant ’option :

— Auto, les états seront codés selon les options sélectionnées par 1'utilisateur dans le synthétiseur.

— Specified, U'utilisateur peut spécifier le codage de chaque état dans ”HDL Designer” en allant dans
les propriétés des états.

— les autres choix ne sont pas tres intéressants dans le cadre du laboratoire.

3.5.4.3 Statement Blocks

Les Global Actions permettent de spécifier des actions placées au début du processus de sorties (quel
que soit I’état courant).

Les Concurrent Statements permettent de définir des instructions concurrentes au graphe d’états.

Les State Register Statements permettent de spécifier les actions & effectuer sur le flanc (montant
ou descendant) de I’horloge. Si une action est spécifiée dans ce champ, il faut également effectuer
explicitement l'affectation de I’état futur a 1’état présent. Si ce champ est laissé vide, 'affectation
de I'état futur a I’état présent est effectuée de maniére implicite.

Affectation d’une sortie a un bit d’état Il est parfois nécessaire d’avoir des sorties qui n’ont pas
d’aléas (par exemple lorsque elles commandent des bascules RS). Un des moyens est d’avoir les
sorties qui correspondent directement a un bit d’état. Pour ce faire, il faut :

— Coder les états de fagon qu’'un bit correspond toujours & la valeur voulue pour une sortie (cf. §
“Encoding”)
— Dans “Concurrent Statements” de 'onglet “Statement Block” des propriétés de la machine ajoutez :

maSortie < Etatpresent(x);

— ma sortie : nom de la sortie en question.
— Etat_Present : c’est le nom donner a I’état en court. Il est spécifier dans 'onglet “Generation”
des propriétés de la machine.

3.5.4.4 Declarations Blocks

Les déclarations faites sous cet onglet apparaitront dans la partie déclarative de ’architecture. C’est
dans celle-ci que 'on trouve, entre autres, la déclaration des signaux internes comme, par exemple,
I’expression ci-dessous :

signal Capt : Std_Logic_Vector(1 downto 0);

Process Declarations Les déclarations faites sous cet onglet apparaitront dans la partie déclarative
du processus de mémorisation ainsi que du processus de sorties.

3.5.4.5 Signals Status

Permet de spécifier les caractéristiques des signaux internes et des sorties. Les valeurs spécifiées dans
le champ ”Default value” sont affectées aux signaux correspondants au début du processus de sorties.

Remarque : Cette assignation de valeurs par défaut permet d’éviter la création de "latches” par
inadvertance, lorsque I'on oublie de spécifier un des cas dans I'affectation des sorties ou si le nombre
d’état de la machine est inférieur au nombre maximum possible (soit 2n ou n est le nombre de bit
de la machine).

Le champ “Status” permet de choisir entre trois possibilités :

35



REDS - HEIG-VD Outils d’aide a la conception de circuits numériques

— “COMBINATORIAL” : La sortie est calculée de facon combinatoire a partir des bits d’état et, pour
une sortie de type Mealy, d’'une combinaison des entrées. C’est, généralement, cette possibilité que
lon utilise pour la réalisation de graphes d’états.

— “REGISTERED? : La sortie est calculée dans le décodeur de sortie puis elle est synchronisée par un
registre ce qui permet d’obtenir une sortie sans transitoire. Cette possibilité a comme inconvénient
de rajouter une bascule supplémentaire par sortie.

— “CLOCKED” Le comportement des sorties obtenu est exactement le méme qu’avec le status
“REGISTERED?” et il y a également adjonction d’un flip-flop par sortie. Cependant alors que
dans l'option “REGISTERED” un signal interne correspondant a la sortie avant synchronisation
est disponible, ce n’est pas le cas dans loption “CLOCKED?”. Le signal interne est directement
celui issu des flip-flops de post-synchronisation, donc identique a celui de sortie. Avec cette option,
il n’est pas nécessaire de spécifier une valeur de sortie par défaut.

3.5.5 Exemple d’'une machine d’état

Nous allons illustrer les points précédents en prenant comme exemple un détecteur de flancs.

Ce systeme est composé d’une entrée Signal et de deux sorties Pulse et S_Active, ainsi qu’une entrée
pour I'horloge (Clk) et une entrée pour le reset (Reset).

—> Pulse
Détecteur

Signal ='0" Signal 3
de flancs

> S_Acif

S_Actif <= 0;
Pulse <=0;

Active

End

S_Actif <= 1;
Pulse <= 1;

S_Actif <= Signal;}
Pulse <= 1;

Signal ='1"

FIGURE 3.12 — Schéma de conception de cette machine d’état

La sortie Pulse fournit une pulse lors du passage de l'entrée Signal de 0’ & ’I’. Cette pulse a une
durée d’une période d’horloge.

La sortie S_active a le méme comportement que Pulse, elle s’active au méme moment, mais se
désactive lorsque Signal passe de '1’ a ’0’. La durée minimum est d’une période d’horloge.

State Register Statements

Process Declarations

Signal_i="1"

S_Ends

S_Active_o <= Signal_iy

F1GURE 3.13 — Machine du détecteur de flancs réalisée sous HDL Designer
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Le code VHDL généré par HDL Designer résultant de la figure 3- 12 est donnée a la figure figure 3-

"current_state"

1 architecture fsm of Detecteur_Flancs is
2

3 — Architecture Declarations

4 type state_type is (

5 S_Wait,

6 S_Active,

7 S_Ends

8 )i

9

10 — State vector declaration

11 attribute state_vector : string;
12 attribute state_vector of fsm : architecture is
13

14

15 — Declare current and next state signals
16 signal current_state : state_type ;
17 signal next_state : state_type ;
18

19 begin

20

21

22 clocked : process/(

23 Clk_1i,

24 Reset_1i

25 )

26

27 begin

28 if (Reset_i = ’1’') then

29 current_state <= S_Wait;
30 — Reset Values

31 elsif (Clk_i’event and Clk_i = ’1’) then
32 current_state <= next_state;
33 — Default Assignment To Internals
34

35 end if;

36

37 end process clocked;

38

39

40 nextstate : process (

41 Signal_i,

42 current_state

43 )

44

45 begin

46 case current_state is

47 when S_Wait =>

48 if ( Signal_i = ’1’ ) then
49 next_state <= S_Active;
50 else

51 next_state <= S_Wait;
52 end if;

53 when S_Active =>

54 next_state <= S_Ends;
55 when S_Ends =>

56 if ( Signal_i = ’0’ ) then
57 next_state <= S_Wait;
58 else

59 next_state <= S_Ends;
60 end if;

61 when others =>

62 next_state <= S_Wait;

63 end case;

64

65 end process nextstate;

66

67

68 output : process (

69 Signal_i,

70 current_state

71 )

72

73 begin

74 — Default Assignment

75 Pulse_o <= '0’;

76 S_Active_o <= '0’;

77 — Default Assignment To Internals
78

79 — Combined Actions

80 case current_state is

81 when S_Active =>

82 Pulse_o <= "1’ ;

83 S_Active_o <= '1’;

84 when S_Ends =>

85 S_Active_o <= Signal_i;
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86 when others =>

87 null;

88 end case;

89

90 end process output;

91

92 — Concurrent Statements

93
94 end fsm;

Listing 3.1 — Code généré par HDL Designer

3.6 Cohérence des symboles (composants ou blocs)

L’interface entre les différentes vues d’un symbole et les différents emplacements ou celui-ci peut-étre

instancié, est définie par les ports se trouvant sur le composant ou par les connexions arrivant sur le
bloc.

Lorsque cette interface est modifiée, la cohérence entre ses différentes vues et ses instanciations n’est
pas toujours assurée. Dans certains cas, il s’avere nécessaire de rétablir la cohérence de maniere
explicite.

Les points suivants expliquent la maniere de procéder afin de maintenir la cohérence lors de la
modification d’une interface.

3.6.1 Cohérence entre un symbole et ses vues

3.6.1.1 Schéma bloc

Pour rétablir la cohérence entre un symbole et son schéma bloc, il faut aller dans le schéma bloc, s’as-
surer qu’aucun symbole (composant ou bloc) n’est sélectionné, puis aller dans les menus “Diagram”
> “Update” > “Interface...”. Le dialogue suivant apparait :

x|

DIFFERENT. Instances

ied on Majorte/Majorte_top/siuct

o with

aused by:

te/Majorte_top/sruct) is:

i

Options

© Mske the component nteface consistent wih the active view

K Cancel o | Hep |

FIGURE 3.14 — Fenétre pour la cohérence entre un symbole et une de ces vues

Si le schéma-bloc n’est pas cohérent avec son symbole, le texte “The Interfaces are DIFFERENT” ap-
parait au sommet du dialogue. Dans le cas contraire, le texte “Interfaces are IDENTICAL” apparait
au sommet de celui-ci.

Lorsque le schéma-bloc n’est pas cohérent avec son symbole, il faut sélectionner le choix “Make active
view consistent with its interface” puis cliquer sur le bouton “OK”. Cette opération va modifier les
“ports” du schéma bloc afin qu’ils correspondent & ceux présent dans le symbole (composant ou
bloc).

3.6.1.2 Description VHDL

Pour maintenir la cohérence entre une description VHDL et son symbole, il faut s’assurer que le
nom spécifié dans la déclaration de 'architecture correspond bien au nom du symbole (composant
ou bloc).
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1 architecture Comport of Nom_Symbole is
2 begin
3 end Comport;

Listing 3.2 — Description VHDL

3.7 Importation d’une description textuelle VHDL

Il est possible d’importer des fichiers contenant une description VHDL (une entité et une architec-
ture), dans une des bibliotheques associées &4 un projet.

Lors de l'importation (ou convertion), on peut demander que ces descriptions soient représentées,
a condition que cela soit possible, sous forme de schéma-bloc, de graphe d’états ou de description
VHDL (textuelle).

1. Pour importer des descriptions VHDL dans une bibliotheque, il faut aller dans la bare de
gauche Main > New/Add. Suite & cette opération, la fenétre de la figure [3.15|s’ouvre.

2. Sélectionnez les options <Add Ezxisting Files to Library>.
3. Sélectionnez la librairie qui va recevoir le fichier vhdl.

4. Cliquez sur Nezt >. Suite a cette opération, la fenétre de la fiugre [3.15] s’ouvre.

£ 7B EAHnRE D)6 065 &R Y-8
z z )
Tipe Extends: Language Tine Stamp

Component VHDL Filhug 29 2008 0825
Component VHDL Thbay 11 2008 141

x|

G Design Content Creation Wiz

Categ

ting HDL Design o Project>
< to Libran |

REDS._ L Base ‘ 3
REDS L 1D

e
VHDL File
Veriog Fle
Text Fie

Ra5 or Capy axisting sourcs les  Worary, Majarts (Acive Lbrary)

Net> Cancel Help

FI1GURE 3.15 — Ajout de sources VHDL

Une fois la fenétre “Add Existing Files To Library...”(figure [3.16) ouverte :

1. Sélectionnez “Copy specified files” sous la rubrique “Addition Method”. Ceci aura pour but de
copier le fichier VHDL dans le répertoir VHDL de votre librairie.

2. Vérifiez que le répertoire de destination et bien le dossier VHDL de votre librairie.

3. Rechercher le répertoire contenant le fichier VHDL original au moyen de la fenétre Folders ou
du bouton Browse.

4. Sélectionnez le ou les fichiers VHDL & copier en cochant les cases correspondantes.

5. Cliquez sur OK.
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"4 Add Existing Files To Library "Majorite”
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- Please choose one of the following methods to add eisting design files inte your library.
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FI1GURE 3.16 — Sélection fichiers vhdl a ajouter dans le projet




Simulation avec ModelSim

Maintenant que notre schéma est terminé, nous pouvons le vérifier. Le simulateur, que nous utilisons
travaille avec des descriptions VHDL. La premiere étape consistera a générer la description VHDL
a partir du schéma et a le compiler afin de pouvoir les simuler avec ModelSim.

Il y a deux méthodes pour simuler le circuit précedemment décrit :

— La simulation manuelle
— Elle consiste a donner des valeurs de stimulation aux entrées de maniere manuelle et de vérifier
visuellement les résultats obtenus. L’assignation des stimulis et la visualisation des signaux se
fait dans HDL Designer et a ’aide d’une console graphique.
— La simulation automatique
— Celle-ci utilise un banc de test. Ce banc de test génére des stimulations pour le circuit a tester
et génere des valeurs de référence. Ces valeurs de référence sont comparées aux valeurs fournies
par le composant testé (simulé). Si les valeurs obtenues et les références ne sont pas identiques,
des messages d’erreur sont générés automatiquement.

4.1 Simulation manuelle

4.1.1 Présentation de la console de simulation

Pour réaliser une simulation manuelle, il faut pouvoir assigner des valeurs aux entrées et visualiser
les valeurs obtenues sur les sorties. Ces tiches sont réalisées a 'aide de la console REDS_console (cf.

figure .

|*; REDS Console: 1.0d o ] 4|
Décimale Hex
Fesul & I I
Result B I I

@@@@@@@@ Hes 1 Hex. 0 7 seq.

L¥ L6 L5 L4 L3 L2 L1 Lo

1 1 1 1 1 1 1 1 Value A I— ul
D? D? Dﬁ Dﬁ Dﬁ Dﬁ Dﬁ Dﬁ “Yalue B I Restart

Quitter

Fil

FIGURE 4.1 — Console pour la simulation manuelle

Les liens entre les signaux disponibles dans le composant a tester et les signaux de la console sont
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réalisés dans le composant Top_Sim (disponible dans la bibliotheque de travail et la bibliotheque
REDS_Lib_10). Ce composant contient tous les signaux disponibles de la console (cf. figure .

Package List

LIBRARY ieee;

USE ieee.std_logic_1164.ALL;

--USE ieee.numeric_std.ALL;
Entrées des 8 interupteurs
S0_i p———0
s1_i p————0
s2_i p————0
3| p————0
s4_| p————0
s5.i p———o—0
s6_i p———————0
7| p—————0

L0_o
L1 o
120
L3.0  Sorite surles8 leds
L4_o
5.0
L6_o
L70

) Hex0_o
Valeurs 8 bits. Entrée sous -

forme hexa ou décimal
Exemple
0x10 (en hexa) ou 16 (en décimal)

Va B i [P -eee)
Val_A i D -e——

Valeurs pour les afficheurs
Hex1_o  Hexadécimaux

sg7 Ao  Sgauxde commande
e pour I'afficheur 7 segments
sg7_B_o
seg7_C_o a
seg7_D_o flgl
seg7_E_o |‘——}
seg7_F_o [
seg7_G_o

Result Ao Resultat
sur 8 bits
Result B o (Hex ou décimal)

) 1

FIGURE 4.2 — Signaux diponible dans le composant Top_Sim

4.1.2 Signaux disponibles

Cette console est composée des éléments suivants :

— Une série de 8 interrupteurs, S0 a S7 liés aux signaux S0_i a S7-i du composant Top_Sim.

— Deux zones pour 'affectation d’une valeur sur 8 bits, Val A et Val B. Il est possible d’entrer les
valeurs sous forme décimale (de 0 & 255) ou sous forme hexadécimale (0x00 & OxFF). Les signaux
associés sont les vecteurs Val_A_i et Val_B_i, tout deux de 8 bits. Remarque : sila valeur d’entrée
est erronée, la console force les entrées a la valeur non initialisée (“UUUTUUUUU”).

— Une série de 8 led, L0 a L7, liées aux signaux LO_o a L7 o.

— Deux zones de lecture de valeurs 8 bits (Result A et Result B). Ces valeurs sont affichées sous la
forme hexadécimale et décimale. Les signaux associés sont les vecteurs Result_A_o et Result_B_o,
tout deux de 8 bits. Remarque : Si la valeur fournie par le composant n’est pas une valeur comprise
entre 0 et 255 (par exemple une valeur non initialisée, “UUUUUUUU”), rien n’est affiché.

— Deux afficheurs hexadécimaux, liés aux signaux Hexz0O-o et Hexl_o (signaux de 4 bits). Ils per-
mettent d’afficher les valeurs de 0 & 9 et de A a F.

— Un afficheur 7 segments. Chaque segment de cet afficheur est lié avec un signal indépendant (de
Seg7_a_o & Seg7_g_o). Ceci permet de commander chaque segment individuellement selon la figure
4.0l

FI1GURE 4.3 — Décomposition d’un afficheur 7 segments

— Les boutons de commande
— Run : Validation des affectations réalisées sur les entrées, avance le temps simulé de 100 ns
(ModelSim évalue 1'état des sorties) puis affichage des résultats obtenus.
— Restart : Relance une simulation. Lors du relancement d’une simulation, les derniers fichiers
modifiés, par exemple suite a la correction d’une erreur, sont rechargés.
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— Quitter : Quitte le simulateur.

4.1.3 Connexion de la console

Pour préparer une simulation manuelle, il faut connecter le composant & simuler dans Top_Sim. Pour
ce faire, veuillez suivre les points suivants :

Sélectionnez la bibliotheque de travail a ’aide des onglets.
Double-cliquez sur le composant Top_Sim.
Dans la nouvelle fenétre, ajoutez (instanciez) le composant que vous voulez tester en ouvrant le

Component Browser en utilisant 1'outil d’ajout de composants ( B Add component).
Faites les liaisons entre les entrées/sorties de votre composant et les signaux de Top_Sim.
Sauvegardez les modifications.

La figure [£.4] donne une vue du résultat obtenu pour le composant Majorite_top.

Vote1_i

Vote2_i

Vote3_i

Majorite
Majorite_top
10

Maj_o

p———— I o

Signaux non utilisés
dans cet exemple

Entrées des 8 interupteurs

S3_i p————0
S4_i p——0
ss_i p——0
S6_i ——0
i p————0

Valeurs 8 bits. Entrée sous

forme hexa ou décimal
Exemple

0x10 (en hexa) ou 16 (en décimal)
Val_A_i IO
Va_B_i IO

O———— I 1o
O—— I 120
O——I» 130
O—— I 140
O—— I 150
O——— i 160
O——I» 170

O ) Hex0_0
O @ Hex1_o

O———— 1 g7 Ao
O——— I g7 Bo
O—— I g7 Co
O———— g7 Do
O—— g7 Eo
O——— I g7 Fo
O———I g7 Go

O ) Resullt A 0
O ) Result_B_0

Sorite surles 8 leds

Valeurs pour les afficheurs
Hexadécimaux

sigaux de commande
pour I'afficheur 7 segments

| @] »
T

|
e

Résultat
sur 8 bits
(Hex ou décimal)

FIGURE 4.4 — Composant Top_Sim intégrant le composant Majorite_top

Dans le cas ou le composant Top_Sim n’éxiste pas dans votre projet, il est possible de le copier
depuis la bibliotheque REDS_Lib_IO. La marche a suivre est la suivante :

ouvrir la librairie REDS_Lib_I0.
sélectionner le composant Top_Sim et le copier (menu Edit > Copy).

aller dans bibliotheque Nom_Projet (important : il faut sélectionner le top de la bibliotheque).
coller le composant Top_Sim (menu Edit > Paste).

4.1.4 Génération, compilation

Les étapes de génération et de compilation permettront de vérifier que votre schéma est SYNTAXI-
QUEMENT correct. Cela ne veut en aucun cas dire que votre conception fonctionne !

Pour lancer la génération et la compilation, il faut :

— Retourner dans Design Manager et choisir I'onglet de votre librairie, dans notre exemple Majorite.
— Sélectionner le composant Top_Sim.
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— Double-cliquez sur “Generate “dans la fenétre Tasks (en haut & droite), cf.figure .
— Double-cliquez sur “DesignChecker Flow “dans la fenétre Tasks (en haut & droite) ou cliquez sur
“Check”(icone & gauche) , cf.figure [.5)).

W Design Manager - Project Majorite =
Fle St View HOL Tosks Tools Options Window Help

(@-F80-t BEX 72 7ULaNRE D5 28 230

Main

2o d>x] Tacks

Design Exploter [ Using viewpoint - Default Viewpoint (Filtered) - Dont Touch Hidden |

v o Majorite_tep Compsnent
&8l Top_Sim Compsnent

Generate

DesignChecker Flow

v lis e lie

H
i

ModelSim Simulate REDS

i

e

ModelSim Comp/Sim REDS

FIGURE 4.5 — Fenétre des tasks

Cette étape provoquera l'ouverture d’une fenétre de ”log”. Regardez s’il n’y a pas d’erreurs ou de
warnings (lignes rouges) et que la derniére inscription porte la mention :

”Data preparation step completed, check transcript...”

Dans ce cas, votre description a une syntaxe correcte. Dans le cas contraire, il y a une/des erreur(s).
11 faut donc corriger cette/ces erreur(s) et relancer la compilation !

4.1.5 Lancement du simulateur

Toujours en sélectionnant le composant Top_Sim, double-cliquez sur “ModelSim Simulate REDS”
dans la fenétre Tasks pour lancer le simulateur.

Remarque : cette action ne recompile pas le composant.

Pour effectuer le flow compet (Generate, compile, run Modelsim), il faut double-cliquez sur “Model-
Sim Comp/Sim REDS” dans la fenétre Tasks.

La fenétre de dialogue qui apparait permet de configurer certains parametres comme le pas de
simulation (délai entre chaque calcul des signaux). Les parametres par défaut conviennent > Cliquer
sur "OK?”.

ModelSim se lance. Attendez que les fenétres soient complétement ouvertes.
Une fois le simulateur ModelSim lancé, ouvrez la console a I’aide du bouton REDS_console qui se

trouve dans la fenétre principale de ModelSim (cf. figure .
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Bouton de lancement de la console

1 ModelSim SF 6.3g
File Edit View Compile Simulate Add Wave Tools Layout Dalng Window Help

D2 MES P oo || foe [ HomM || L LN
JLMW.WﬂHQqu”@ @ras| [FEDs_consor]

Workspace HA x| Transcript Ha
¥|Instance = // OF MENTOR GRAPHICS CORPORATION OR ITS LICENSORS ;I
|| |-/ 0 5 3257 o ieE e,
Il std_logi
B standerd
W numeric_std
2 Loading ieee.std_|
= Loading ieee,numi
= Loading work. wes
= do C:/EDA/Tox QuestaSim/QuestaSim.do
= 1270
= 1270x974+0+0
= .main_pane,mdi,interior.cs.vm,paneset.di_0.wf.dip.cs.p f
= 5 | s -
ImL.xyaw l &l sm [ £ Fles l B8 Memories I KL -[ HTransmpt] KC]

FIGURE 4.6 — Bouton de lancement de la console

Maintenant, vous devez retourner dans la fenétre du schéma réalisé sous HDL Designer (pour notre
exemple Majorite_top). Si nécessaire, vous devez rouvrir le schéma.

La barre d’outils utilisée pour la simulation manuelle apparait au bas de cette fenétre (cf. figure .
Si ce n’est pas le cas, cliquez avec le bouton de droite dans ’espace libre laissé a c6té d’une autre
barre d’outils pour ouvrir le menu contextuel, et sélectionnez Simulation Tools.

B C-RBHBP RO NSO RERLY /CHNBR Y M

FIGURE 4.7 — Barre d’outils pour la simulation

4.1.6 Les sondes

Nous allons utiliser des sondes pour visualiser les valeurs des signaux disponibles dans le schéma.
Pour ajouter une sonde a un signal, il faut le sélectionner. Si vous avez plusieurs sondes a rajouter,

vous pouvez faire une multi-sélection. Cliquez ensuite sur le bouton B e 1a barre des outils de
simulation.

4.1.7 Simulation et assignation des entrées

L’assignation des valeurs aux entrées se fait avec les boutons disponibles sur la console. Pour changer
la valeur d’un bouton, il faut cliquer sur celui-ci. La visualisation des sorties se fait au travers des
leds ou des afficheurs 7 segments ou hexadécimaux. Afin de valider les nouvelles valeurs choisies et
d’obtenir I’état des sorties, il faut cliquer sur le bouton Run.

Astuce : Mettez la console devant la fenétre du schéma, ainsi les deux fenétres sont visibles et il
est aisé de voir I’évolution des signaux selon les valeurs fournies aux entreés.
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Vote1_i  E—
Vote2_j D /
—

Vote12_s

Vote13_s
Vote1 i

Vote23_s 1 — W Ma_o

Vote3_i

T

Vote2_i
1
Vote3_i

REDS Console: 1.0¢ k- o ] 3

Hex  Décimale
A I— l— — —
Result B [ I |
Gnd o 00 AT BT T SRl (T | '
7} 7 16 L5 W 1B 2 U1 W
HEX 1 HEX 0 7seq 0
1 1 1 1 1 1 B 1 1 3 valia l— Run
ﬂﬁ Uﬁ ﬂﬁ UR ﬂﬁ o Dﬁ o Val B Restart
S7 S5 S5 S4 S3 S2 S1 SO
Quitter

FIGURE 4.8 — Visualisation du schéma apres 1'ajout des sondes

Remarque : Les connexions entre les signaux de la console et du composant a tester sont réalisées
dans le composant Top_Sim.

4.1.8 Preuve de la simulation manuel

Il est possible de voir I’évolution des signaux sur un chronogramme (cf. figure . Ceci permet de
fournir une preuve des cas simulés manuellement. Dans le chronogramme il est nécessaire d’ajouter
toutes les entrées et toutes les sorties du systeme en cours de vérification. Il est important de
prendre les signaux du composant et pas ceux de Top_Sim afin de voir les noms des signaux dans
le chronogramme. Vous pouvez vous référer aux explications du § [£:2.3] "Préparation en vue de la
simulation” pour préparer le chronogramme.

e - Uelaull | | =101 =|

Fi= Edt Uiew In=rt Format Jook Debug  Sindow

JomEM||Naieg || iDaaE]|ige

J
trrnnnierereneberenpe e nr e rne e enene g .
1 2m 40 J={i1] |
Bdre |

|||4|r||-\| ] .
[0'ns ta B0 ne | P

F1GURE 4.9 — Chronogramme de quelques pas lors d’une simulation manuel

Il faut aussi fournir la fenétre log de ModelSim afin de connaitre quels sont les composants qui ont
été chargés.

:/EDA/HDS/v2004_1/resources/downstream/modelsim/ModelSim_32Bit.dl1l
:\EDA\ModelSim\v5_8c\win32/../std.standard

Loading C:\EDA\ModelSim\v5_8c\win32/../ieee.std_logic_1164 (body)

Loading C:\EDA\ModelSim\v5_8c\win32/../ieee.numeric_std (body)

Loading C
(@
C
@
Loading D:\Projects\OutilsEDA\Majorite_proj/Majorite/Comp.top_sim(struct)
D
D
D
D

Loading

Loading D:\Projects\OutilsEDA\Majorite_proj/Majorite/Comp.majorite_top (struct)
Loading D:\Projects\OutilsEDA\Majorite_proj/REDS_Lib_Base/Comp.and2 (logic)
Loading D:\Projects\OutilsEDA\Majorite_proj/REDS_Lib_Base/Comp.gnd (logic)
Loading D:\Projects\OutilsEDA\Majorite_proj/REDS_Lib_Base/Comp.or4 (logic)

© 0 NG W N R
B e

Listing 4.1 — Log lors du chargement de Top_Sim avec le projet Majorite
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4.1.9 Corrections

Si vous avez une correction & apporter au schéma, vous étes obligés d’enlever les sondes. Pour cela,

cliquez sur le bouton b

Une fois votre schéma corrigé, relancez le script de compilation pour le simulateur (bouton Compile
dans la fenétre Tasks). Il n’est pas nécessaire de relancer le simulateur. Par contre, une remise a
zéro est nécessaire, cliquez sur le bouton Restart de la console. Réassignez vos entrées et relancez la
simulation.

4.1.10 Quitter le simulateur

Pour fermer le simulateur, cliquez avec le bouton Quitter de la console.

4.2 Simulation automatique

4.2.1 Génération et Compilation

Les étapes de génération et de compilation permettront de vérifier que votre schéma est SYNTAXI-
QUEMENT correct. Cela ne veut en aucun cas dire que votre conception fonctionne!

Pour lancer la génération et la compilation, il faut :

Retrouner dans Design Manager et choisir I'onglet de votre librairie, dans notre exemple Majorite.
— Sélectionner le composant *_top_tb. Dans le cas de 'exemple : Majorite_top_tb.

Double-cliquez sur “Generate “dans la fenétre Tasks (en haut & droite), cf.figure .

— Double-cliquez sur “DesignChecker Flow “dans la fenétre Tasks (en haut a droite) ou cliquez sur
“Check”(icone & gauche) , cf.figure [£.10).

W Design Manager - Project Majorite

OL Tasks Tools Options Wmndow Help

._J‘\ Generate

= DesignChecker Flow

e

— ModelSim Simulate REDS
ModelSim Comp/Sim REDS

FIGURE 4.10 — Fenétre des tasks

Cette étape provoquera l'ouverture d’une fenétre de log. Regardez s’il n’y a pas d’erreurs ou de
warnings (lignes rouges) et que la derniére inscription porte la mention :

”Data preparation step completed, check transcript...”

Dans ce cas, votre description a une syntaxe correcte. Dans le cas contraire, il y a une/des erreur(s).
Il faut donc corriger cette/ces erreur(s) et essayer de compiler & nouveau !
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4.2.2 Lancement du simulateur

Toujours en sélectionnant le composant *_tb (dans le cas de 'exemple Majorite_top_tb), cliquez sur
“ModelSim Simulate REDS” dans le fenétre Tasks.

La fenétre de dialogue qui apparalt permet de configurer certains parametres comme le pas de
simulation (délai entre chaque calcul des signaux). Les parametres par défaut conviennent > Cliquer

sur OK.

ModelSim se lance. Attendez que les fenétres soient complétement ouvertes.

4.2.3 Préparation en vue de la simulation
4.2.3.1 Ajout des traces dans le chronogramme

Sélectionnez les signaux dont on désire garder la trace, dans la fenétre signals puis déplacer-les, a
I’aide de la souris, dans la fenétre wave.

Il est possible de se déplacer dans la structure du composant simulé en sélectionnant les différents
modules dans la fenétre structure (situé dans la fenétre principale). La fenétre signals montre les
signaux du module actuellement sélectionné, ce qui permet de les ajouter dans la fenétre wave.

4.2.3.2 Ajout d'intercalaire (en anglais "divider”)

Il est possible d’ajouter des intercalaires entre les différentes traces afin d’améliorer la lisibilité du
chronogramme.

Pour ajouter un intercalaire, allez dans les menus Insert > Divider. .. de la fenétre wave ou effectuez
un clic droite de la souris et sélectionnez le menu Insert divider. Le dialogue suivant apparait :

Wave Divider Pro |

— Divider Name

|New Diivider

— Divider Height
|17

aF. | I:ancell

FIGURE 4.11 — Création d’un intercalaire

Dans ce dialogue, remplacer le texte New Divider par une chaine de caracteres caractérisant 'inter-
calaire. Cette chaine est indicative et peut donc contenir n’importe quels caractéres imprimables.

4.2.3.3 Formatage des traces

Pour effectuer la mise en forme d’une trace dans le chronogramme, il faut cliquer sur le bouton
droite de la souris et sélectionner le menu ”Properties. ..” sur le nom du signal que ’on veut changer
le formatage. Le dialogue suivant apparait :
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53 Wave Properties x|
Signal: sim: fmajorite_top/vote3_i

view | Format | Compare

"D\splav
Wave Color

Radix Colors..|

=

L el [& | Name coor
= | coos.

ok | _cancel | _apply

FIGURE 4.12 — Fenétre de formatage des traces d’un chronogramme

Les champs intéressants, pour les systemes logiques, permettent de spécifier :

— Radiz
— la base de la représentation du signal. Ce qui permet, par exemple, de représenter la valeur
entiere d’un compteur a ’aide du choix ”Unsigned”.
— Display Name
— permet de spécifier le nom a afficher a la place du nom du signal.

4.2.4 Lancement de la simulation

Aller dans les menus Simulate > Run > Run -all de la fenétre principale ou cliquer sur le bouton

se trouvant dans la fenétre wave afin d’effectuer la simulation.

La simulation s’arrétera des que les valeurs des entrées et des sorties resteront constantes, typique-
ment lorsqu’un "wait ;” est rencontré dans la description VHDL du test bench.

4.2.5 Preuve de la simulation

La preuve d’une simulation est donnée dans la fenétre Log de ModelSim (fenétre principale de Ioutil).
C’est dans cette zone que ModelSim informe 'utilsateur. Les informations importantes sont :

— La liste des fichiers chargés et donc simulés.
— Les messages fournis par le test-bench, par exemple le nombre d’erreur détectées.

1 # Loading C:/EDA/HDS/resources/downstream/modelsim/ModelSim_32Bit.dll
2 # Loading C:\EDA\ModelSim\win32/../std.standard

3 # Loading C:\EDA\ModelSim\win32/../ieee.std_logic_1164 (body)

4 # Loading C:\EDA\ModelSim\win32/../ieee.numeric_std (body)

5 # Loading D:\Projet\Majorite_proj/Majorite/Comp.majorite_top_tb (struct)
6 # Loading D:\Projet\Majorite_proj/Majorite/Comp.majorite_top (struct)
7 # Loading D:\Projet\Majorite_proj/ReDS_lib_Base/Comp.and2 (logic)

8 # Loading D:\Projet\Majorite_proj/ReDS_lib_Base/Comp.gnd(logic)

9 # Loading D:\Projet\Majorite_proj/ReDS_lib_Base/Comp.or4 (logic)

10 # Loading D:\Projet\Majorite_proj/Majorite/Comp.majorite_top_tester (test_bench)
11 # do C:/EDA/ModelSim/v5_6c/ModelSim.do

12 # 900x300+0+0

13 # 1272x604+0+346

14 # 364x300+908+0

15 # hdsAddWaveButtons AddWaves

16 # .signals

17 # .wave

18 run —all

19 # xx Note: >>Debut de la simulation

20 # Time: 0 ns Iteration: 0 Instance: /majorite_top_tb/il

21 # ** Note: >>Nombre d’Erreur_s détectée = 0

22 # Time: 800 ns Iteration: 0 Instance: /majorite_top_tb/il

23 # *x Note: >>Fin de la simulation

24 # Time: 800 ns Iteration: 0 Instance: /majorite_top_tb/il

Listing 4.2 — Informations fournies par la fenétre Log

A titre de documentation, nous pouvons imprimer le chronogramme de la simulation comme le
montre la figure [4.13
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T -Ioix)

File Edit View Insert Format Tools Debug MWindow

(@& s m@a|n x| Q@] i n=e

— Entrees
/maijorite_top_th/vote
/maijorite_top_tb/vote:
/maijorite_top_th/vote:

— Sortie - reference et observee
...fite_top_tb/i1/mal_obs |1
...onite_top_th/i1/mai_ref |1

R |

...fite_top_th/i1 ferreur_s

' R ”””IHZDU‘”””” ””””“100‘”””” ‘...‘...ém‘...u... H”””’SDU‘
V| T |

|Dn910815 ns |

N [ [S—"

FI1GURE 4.13 — Chronogramme de la simulation automatique de Majorite_top_tb

4.2.6 Redémarrage de la simulation

Pour relancer la simulation (du méme module), cliquez sur le bouton ou aller dans les menus
Simulate > Run > Restart. ...

Lorsque l'on relance la simulation, les derniers fichiers compilés du module sont rechargés pour étre
simulé.

4.2.7 Impression du chronogramme
4.2.7.1 Mise en page...

Aller dans les menus File > Page setup. .. depuis la fenétre Wave.

£
[ Paper [ Unit; [ Margir
Paper size: Top: |1.2? ::I
4 Sheet > " inches Battom: [1.27 =
widthe 7 = @ i et 127 =
Height: EX= Fint [127 =
rLabelwidth——————— Curzors ~Grid —Calar
 Color
* Auto Adiust o o
 Grayscale
O Fiedwidth: [381 = € on & On
% Bt
~Scaling ~ Orientation
" Fiwed  |G00ns :’ e page - " Porrait
.A
& Ette |1 2 pagels) wide & Landscape

K | Cancel

FIGURE 4.14 — Parametres pour I'impression

Le parametre le plus intéressant dans ce dialogue est la mise & 1'échelle (Scaling). Il permet de
spécifier selon 'option choisie :

— Fized ? per page
— la durée maximale de simulation a afficher par page.
— Fit to ? page(s) wide
— le nombre de pages sur lequel le chronogramme doit étre imprimé.
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4.2.7.2 Impression...

Aller dans les menus File > Print depuis la fenétre Wave.

Print A
r~Printer
M ame; |\\eintU?\AUU-H PE150 ZI Froperties |
Skatus: Feady

Type: HF Lazerlet 8150 PS Setup... |

‘where: 10,192 48 46:hp8150-a00

Comment:  HP Laserlet 8150 [ Couloir & | ™ Prirtt b file
~Signal Selection———— Time Fange
Al signals € Full Range Ons Ons
" Curment view (¢ Cumentview [Ons Tus
" Selected  Custom Frorm: |0 ns :’ Ta |Ons ::I
Ok | LCancel |

FIGURE 4.15 — Fenétre pour 'impression

Dans ce dialogue, il est possible de spécifier quels sont les signaux du chronogramme que ’on désire
imprimer :

— All signals

— imprime tous les signaux .
— Current view

— imprime les signaux qui sont visibles dans la fenétre.
— Selected

— imprime les signaux qui sont sélectionnés.
Il est également possible de spécifier I'intervalle de temps & imprimer :

— Full Range

— imprime les traces depuis le début de la simulation jusqu’au dernier instant simuler.
— Clurrent view

— imprime les traces sur I'intervalle visible dans la fenétre.
— Custom

— imprime les traces sur 'intervalle spécifier dans les deux champs suivant.

4.2.8 Sauvegarde des traces du chronogramme

Il y a deux méthodes pour sauvegarder un chronogramme :

— Sauvegarde de la structure d’un chronogramme, soit les noms des signaux et les intercalaires
présent dans la fenétre Wawve. Cela permet de retrouver 'environnement de travail d’une session
de simulation a 'autre.

— Sauvegarde dans un fichier graphique, pour la documentation.

4.2.8.1 Sauvegarde de la structure de la fenétre Wave

Sélectionné la fenétre “ Wave” en cliquant dessus.

— Enregistrement

1. Dans les menus File > Save.

2. Choisissez le répertoir ou doit étre enrgistré la configuration(*.do).
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3. Vérifiez que la coche “Waveform formats” est mise.
4. Cliquez sur “Ok”.
— Ouverture

1. Dans les menus File > Load.
2. Sélectionné le fichier de configuration(*.do).

3. Cliquez sur “Quurir”.

4.2.8.2 Sauvegarde de la fenétre Wave dans un fichier bitmap

ModelSim permet de sauvegarder l’état présent d’un chronogramme dans un fichier graphique au
format bitmap.

1. Sélectionné la fenétre “ Wave” en cliquant dessus.
2. Aller dans les menus File > Ezxport.

3. Enregistrer votre image.
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4.3 Option du simulateur

4.3.1 Paramétrisation du simulateur pour les instructions "assert”

Aller dans les menus “Simulate” de la fenétre principale > “Runtime Options...”.

|5 'Simulation Options == =]
Defaults] Azzertions ] WLF Files]
 Default Badix —Suppress Warnings:
" Symbolic [ Fram Synopsys Packages
 Binary [~ From IEEE Mumeric Std Packages
 Dctal
 Decinal —Default Run Default Farce Type
 Unsigred 100 ns ne " Freeze
" Hexadecimal  Iteration Lirnit ® Lo
A E " Deposit
ak. | Lancel | Apply

FIGURE 4.16 — Parametres du simulateur

Sous l'onglet “Assertions”, il est possible d’indiquer au simulateur depuis quel niveau de gravité il
doit suspendre la simulation (spécifié dans la zone “Break on Assertion”) ainsi que les instructions
“assert” qu’il doit ignorer (spécifié dans la zone “Ignore Assertions For”).

4.4 Simulation aprés Placement-Routage

Quartus II fournit les fichiers nécessaires pour effectuer la simulation apres Placement-Routage. 1l

s’agit de

— nomProjet.vho, contenant la description.
— nomProjet_vhd.sdo, contenant les timings.

On peut le trouver a l'adresse :

<nomProjet_proj>\<nomProjet>\ P_R\ Simulation\ modelsim\

Voici les étapes pour réaliser cette simulation :

— Renommez le fichier nomProjet.vho en nomProjet_pr.vhd

— Depuis le "Desing Explorer”, clic-droite sur le composant que 1’on veut simuler. Choisir le menu

“Add” > “Gate Level”.
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zl
i HDL Metlist
Metlist Source
I Erowse... |
Import Metlist to
ID'\Prniacts\ezPElEE\dev\hard\ezF’C\_cnra\ Browse... |
" Import

" Refersnce

¥ Set as Default View

v SDF

I Browse... |

& |mpart

" Reference

o]

Cancel I Help I

FIGURE 4.17 — Importation d’une netlist avec les contraintes de temps

— Dans la fenétre qui s’ouvre (cf. figure
— sous la rubrique “HDL Netlist”, sélectionnez le fichier “nomProjet_pr.vhd”.
— Sélectionnez I'option “SDFE” et choisissez le fichier “nomProjet_vhd.sdo”.
— Choisir deux fois 'option “Copy the netlist file”.

— Validez avec le bouton “OK”.

La suite et la méme que pour une simulation standart. Veuillez donc suivre les instructions depuis
le § “Simulation automatique”.

4.5 Le banc de test

Le Test Bench est une entité destinée uniquement & la simulation (il n’est pas synthétisable et n’a
d’ailleurs ni entrées ni sorties). Le schéma bloc d’un test bench est le suivant :

HRMajorite Majorite_top_tb/struct * (Block Diagram) =lol x|
File Edt View HDL Disgram Tasks Siaulstion Add Options Window OLE Help
[2-«+2ERME&2:2Rjc- B OLALr 70 |& ]
[k-AOF2-¥E0SBMEEE- L - % [=-clo&a]E-

Fhckage (st i sedportn | El

Ports:

ibrary iese; - . :
seieee.std logic_1164.ALL;
Se-ieee numeric_std-ALL;

Diagram Signals:
signal Maj_ohs

signal Votel sti :
signal Votez sti :
signal Voted sti :

: std_logic
=std_logic
std_logic
std logic

Motel i Majorite
Majarite_top
Waote2 j D Maj o [—m
Voted i
Vited_sti
. Majorite -
biCire) Majorite_tap_tester I EEE
n
otel_sti

3

=-l0-N-u

ol S aE T e T

Wdds a port

2

FIGURE 4.18 — Schéma bloc d’un test-bench

Le composant que l'on désire tester (Unit Under Test, UUT) est connecté & un bloc qui fournit les
stimulus et compare les réponses avec les valeurs souhaitées (dans I'exemple Majorite_top_tester).
Le composant et le bloc testeur sont reliés de maniere implicite par des connexions par noms.
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4.5.1 Création du Test Bench

Sélectionnez, dans le Design Ezxplorer, dans la bibliotheque de travail, le composant a simuler (dans
notre exemple Majorite_top) et aller dans les menus “File” > “New” > “Test Bench...”. Dans la
fenétre qui s’ouvre, valider en cliquant sur “OK”.

4.5.2 Connexion des blocs Testeur et UUT

Sélectionnez dans le Design Manager le module qui vient d’étre créé (dans notre exemple Majo-
rite_top_tb) et aller dans les menus File > Open > Design content.

Connecter les signaux ensemble soit par exemple les deux signaux Votel_i, les deux signaux Maj_o.
Puis renommer les signaux qui sortent du tester par *_sti (pour stimuli) et ceux qui entrent dans
le tester par *_obs (pour observé). Dans notre exemple on obtient Votel_sti, Vote2_sti, Vote3_sti et
Maj_obs (cf figure 4- 19) .
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La Synthese est I’étape qui consiste a traduire des descriptions (du VHDL dans notre cas) en équation
logique. Ce travail est réalisé par 'outil Precision Synthesis.

5.1 Lancement de la synthese

— Dans le Design Explorer de HDL Designer, sélectionnez la bibliothéque ou se trouve le composant
a synthétiser.
— Sélectionner le composant a synthétiser, dans le cas de notre exemple Majorite_top.
— Lancer le synthétiseur en double-cliquant sur “Precision Synthesis Flow REDS” dans la fenétre
Tasks.
— Le fichier VHDL contenant 1’ensemble des fichers VHDL hiérarchiques correspondant au com-
posant sélectionné (concaténation) , NomComposant_concat.vhd sera créé automatiquement.

Presicion Synthesis se lance et charge automatiquement les fichiers a synthétiser.

5.2 Interface de precision

Une fois le programme lancé, on obtient la fenétre representée a la figure[5.1} Cette fenétre est divisée
en deux, le Design Bar sur la gauche et une zone d’affichage qui peut étre divisée par un certain
nombre d’onglet.

=lolx

Design Bar

iDL s,

Onglet

FIGURE 5.1 — Fenétre initiale obtenue apres le lancement de Precision Synthesis

Description des onglets :

— Design Bar
— Regroupe les différentes commandes disponibles dans Precision. Elles sont rangées en différents
tiroirs. Ces commandes ne sont disponibles qu’au fur et a mesure que l’on avance dans le projet.
— Onglet
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— Transcript Zone ou sont affichées les informations données par Precision (déroulement du pro-
cess, Warning, erreurs, etc ...).

— Design Centre Zone ou sont regroupées tous les fichiers d’entrées ou de sorties de Precision.
C’est également 1a qu’il est possible d’affecter différentes contraintes au projet.

— D’autres onglets apparaissent pour afficher les informations demandées, par exemple pour affi-
cher les rapports (timing ou Aera) ou pour afficher une vue (RTL ou View Technology Schema-
tic).

5.3 Synthese de la description

5.3.1 Choix de la cible

1. Dans la Design Bar, sélectionnez le tiroir Design.
2. Cliquez sur I'icon Setup Design la figure apparait.
3. Configuration de la cible,

rrosect sengs x
Technology Design Frequency: MHz
[ Altera |
ACEX 1K
APEX 20K Default Input Delay: 0 nhs
APEX 20KC
Default Qutput Delay: l 0 hs

APEX 20KE
I™ HunBetimmng

APEX I

Cyclone

Excalibur-4RM

FLEX 10K

FLEX 10KA

FLEX 10KB

FLEX 10KE =

Device:

EPM71285LC84 ¥ I
Speed Grade:

.15 vl

oK I Cancel I

FIGURE 5.2 — Sélection de la cible

Remarque : Le tableau ci-dessous référence les informations sur les circuits les plus couramment
utilisés au laboratoire. Vérifiez quelle est la cible utilisée !

| Technologie | Device | Speed grade |

EPM7064SLC44 -10 ou -15

Altera MAX 7000S | EPM7128SLC84 -7 ou -15
Altera Acex 1K EP1K30QC208 -3

TABLE 5.1 — Liste des circuits les plus fréquemment utilisés

Le choix de la technologie permet :

— d’orienter “Precision”dans sa maniére de simplifier les “équations logique” (simplification au niveau
des portes logiques).

— de connaitre le circuit cible voulu afin de le transmettre au placeur-routeur. Ceci évite de devoir
le spécifier manuellement lors du placement-routage.

5.3.2 Compilation

Toujours dans le menu Design du Design Bar, lancez la compilation en cliquant sur le bouton
Compile.

o7



REDS - HEIG-VD Outils d’aide a la conception de circuits numériques

Durant cette opération, une analyse est effectuée sur les descriptions VHDL afin les convertir en un
schéma fonctionnel équivalent (fonction logique standard). Il est possible de visualiser ce schéma en
sélectionnant le menu Tools > View > View RTL Schematic.

Remarque : Precision permet d’afficher les schémas dans une ou plusieurs vue. Pour passer d’un
mode & l'autre, faire un click droite sur le graphique et activer (ou désactiver) l'option “MultiPage
Schematics”.

5.3.3 Affectation des broches

Aller dans les menus File > Run Script... puis ouvrir le fichier d’assignation des pins aux ports
(extension “*.tcl”).

5.3.4 Synthesize

Toujours dans le menu Design du Design Bar, lancez la synthése en cliquant sur le bouton Synthesize.

Durant cette phase, Precision Synthesis va essayer de simplifier le schéma de portes équivalent afin
de minimiser soit la place utilisée dans le silicium, soit le temps de propagation entre les entrées et
les sorties.

Il est possible de voir le schéma de portes logiques optimisé pour la technologie sélectionnée en
choisissant dans le menu Tools > View > View Technology Schematic. Durant cette phase, Precision
Synthesis crée aussi les différents fichiers nécessaires pour le placement-Routeur Quartus I1.
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5.4 Fichier d’assignations de “pin”

Le fichier utilisé pour l'assignation des pins est un fichier TCL (“Tool Command Language”). Ce
fichier est un script effectuant une suite de commandes dans “Precision Synthesis”.

5.4.1 Script GenePin.tcl pour carte EPM 25p - 25p

Le script GenePin.tcl permet de générer automatiquement ce fichier d’affectation des pins pour la
carte EPM 25p - 25p disponible au laboratoire.

e )
Connecteur Gauche Connecteur Droite Informations
# Connectewr | _# Broche. Nomdusignal | _ #Connectew | #Bioche Nom dusignal | Maguette. EPM 25p-25p |
3 “ Auteur
] Date
50 Version

Horloge et Reset
Hotoge [
_ rReset |
Ci cteur J4 7 JP15
#Conn. J4 | #Conn. Jp15| #Broche | Nom dusignal |
2 80

2(N(B|2(L
o

B3 1 7
AL 3 8

A5 4 a
B5 5

R 5|2 (8|88 o
E
o

Generateur de fichier tcl pour carte EPM 25p - 25p
Date : 3 novembre 2004
Version: 1.4

=|o|2(z|z

7 Generer | Lecture | Quitter |

FIGURE 5.3 — Interface du script GenePin.tcl

5.4.2 Syntaxe d’une assignation

Ce fichier est composé d’une suite d’assignation. Il est possible d’ajouter des commentaires en le
faisant précéder du caractere “#”.
set_attribute Nom_Signal -name PIN.NUMBER -value Numero_Pin -port

ou il faut remplacer :

— Nom_Signal Nom du signal auquel le numéro de “pin” doit étre associé. Pour les vecteurs, ce nom
est suivit (sans espace) de l'indice du signal entre parentheses.
— Numero_Pin Numéro de "pin” & associer au signal “Nom_Signal”.

1 # Fichier : Afficheur.tcl

2 #

3

4 # Port d’entree A

5 set_attribute a(4) —name PIN_NUMBER —value 4 —port
6 set_attribute a(3) —name PIN_NUMBER —value 5 —port
7 set_attribute a(2) —name PIN_NUMBER —value 6 —port
8 set_attribute a(l) —name PIN_NUMBER —value 7 —port
9 set_attribute a(0) —name PIN_NUMBER —value 8 —port
10

11

# Port d’entree B

set_attribute b (4) —name PIN_NUMBER —value —port
set_attribute b(3) —name PIN_NUMBER —value 11 —port
set_attribute b(2) —name PIN_NUMBER —value 12 —port
set_attribute b(l) —name PIN_NUMBER —value 13 —port
set_attribute b (0) —name PIN_NUMBER —value 14 —port

e
N oA W N
0

# Port de sortie C

set_attribute s (6) —name PIN_NUMBER —value 18 —port
set_attribute s(5) —name PIN_NUMBER —value 19 —port
set_attribute s (4) —name PIN_NUMBER —value 20 —port
set_attribute s(3) —name PIN_NUMBER —value 21 —port
set_attribute s(2) —name PIN_NUMBER —value 24 —port
set_attribute s (1) —name PIN_NUMBER —value 25 —port
set_attribute s(0) —name PIN_NUMBER —value 26 —port

NN NN NN R
R W N RO O W

Listing 5.1 — Fichiers d’assignation des numéros de pins aux ports
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Pour lancer le logiciel, allez dans les menus :

Démarrer > Labo numérique > EDA > Quartus II 7_2

6.1 Ouverture du projet

Pour créer un nouveau projet, cliquez sur le bouton DL une fenétre s’ouvre. Sélectionnez le répertoire
P_R de la bibliothéque contenant le composant (répertoire ..\ Majorite_proj\ Majorite\ P_R) et valider
en cliquant sur le bouton Créer.

Quartus II crée le projet et ajoute & ce dernier le fichier source (*.edf) ainsi que les contraintes
spécifiées lors de la synthese dans Precision Synthesis.

Remarque : Un bouton a été ajouté dans Quartus : U Ce bouton est utilisé pour rependre un
projet apres la synthése de ce dernier par Precison.

{ Creation de projet, yersion: 1 = |EI|5|

File Infa

Creation d'un projet Quartus Il
Synthetiseur Precision

Séléctionnez votre répertoire de travail
Chaisr | |

[Structure: D:AClazzehGroupetProjet_projProjetP_R]

Créer |

FIGURE 6.1 — Création d’un nouveau projet

6.2 Placement et routage

Affichez la fenétre de compilation en allant dans les menus Quartus II > Compiler Tool. La fenétre
Compiler Tool apparait (cf. figure .

Lancer le placement-routage en cliquant sur le bouton “> Start”.
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izs Compiler Tool =10f x|
—Analysis & Synthesis Fitter Assembler Timing Analyzer—— EDA Netlist Writer—
100 % 100 % 100 % 100 % 100 %
00:00:05 00:00:02 00:00:01 00:00:01 00:00:01
wina BHLew | BEee | »neel ¥uee

100 %
00:00:00

W Start O Stop @ Report

FI1GURE 6.2 — Compiler Tool

6.2.1 Vue RTL

Quartus II permet de voir une vue RTL du projet. Aller dans les menus Quartus II > RTL Viewer.

Vote2 [x45502248514
vote2 i[> ] uTi T Majo .
Vote3 i > uT1 aT_Mal o:0UT 601241 041:0UT1 .
450224851 pOUT ——>Maj_o
p 160601241041
502248515
vote1 i[>

FIGURE 6.3 — Vue RTL du projet Majorite

6.2.2 Visualisation des rapports

Pour visualiser les résultats obtenus lors du placement-routage, Quartus II crée un certain nombre
de fichiers rapports. Pour les visualiser, cliquer sur le bouton Report dans la fenétre Compiler Tool.

6.2.3 Fichier générer

Quartus I génére une grande quantité de fichiers, voici les plus importants :

— *.pof/*.sof fichier de configuration du circuit programmable.
— *fit.rpt résumé du résulat de placement-routage.

— *.fit.eqn fourni les équations logiques obtenues.

— *.pin Liste avec laffectation des broches.

6.3 Programmation

6.3.1 Branchement de la carte

La programmation se fait toujours avec un cable de type ByteBlaster.

Pour la connexion, branchez le cable dans le port imprimante du c6té PC et dans le connecteur
prevu a cette effet sur la carte.

Remarque : Pour chacune des cartes disponibles au laboratoire une documentation a été réalisée.
Veuillez-vous y référer en cas de doute!
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6.3.2 Lancement du programmateur

Pour lancer le programmeur, aller dans les menus Quartus II > Programmer. La fenétre de pro-

grammation apparait (cf. figure [6.5]).

6.3.3 Sélection du "module” de programmation

Le “module” de programmation est un ByteBlaster. Vérifiez que le module ByteBlaser est bien bien

sélectionné (cf. figure , si se n’est pas le cas :

— Cliquez sur le bouton Hardware Setup.

Dans la fenétre qui apparait, sélectionner le ByteBlster dans la zone AvailableHardware items.

— Sur la ligne Currently Selected Hardware, vous devriez avoir ByteBlaster [LPT1].

— Validez avec le bouton Close.

Zone de vérification

Hardware Setup |
Hardware Settings | JTAG Setlings |
Select a programming hardware setup to use wheg/Arogramming devices. This programming
hardware setup applies only to the current prografmer windaw.
urrently selected hardware: ByteBlaster [LFT1]
Ayailable hardware fems:
Select Hardware
s [Server ek | —l
ByteBlaster Local LPT1 Add Hardware...
Fiemoye Hardivare
Zone de
sélection

FIGURE 6.4 — Sélection du module de programmation

6.3.4 Programmation de la carte

=1o0lx|

a?a Hardware Setup... |B.WEB|ES‘9' [LPT1]

Mode: [s1a5

&

Progress: | 1]

W Start File Device Checksum Usercode

Program/
Configure

Verify

it Stop 1. .../BinLin/P_R/Bin_Lin.pof EPM71285L84 001E1784 0000FFFF
*Fn Auto Detect
X Delete

2 Add File...

_ B Change File L < |

FIGURE 6.5 — Fenétre de programmation

— Cochez les cases Program/configure et verify (cf. figure [6.5)).
— Lancez la programmation en cliquant sur le bouton Start.

6.3.5 Reprise d’un projet

]

Pour programmer un circuit a partir d’un fichier de programmation disponible, suivez les étapes

suivantes :

— Lancez le programme Quartus I1.
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Ouvrir le programmeur, avec le menu Quartus II > Programmer.
Sélectionnez le fichier de configurations en cliquant sur le bouton Add File.... Les fichiers de

configurations ont comme extansion *.pof (Maz7000S) ou *.sof (Acex).
Suivre les informations du §[6.3] ”Programmation”
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Annexes

A.1 Convention de noms au REDS

La convention de noms utilisée pour les indentificateurs est la suivante :

— lere lettre en majuscule, le reste en minuscule.
— Chaque mot est séparé par un souligné avec la lére lettre en majuscule.
— Voici quelques exemples :

— Bus_Donnee, Etat_Present, Adr_Sel, Val_Don.

Afin de simplifier la lecture des descriptions VHDL, nous avons défini une convention pour les noms
des signaux. Les tableaux ci-apres vous donnent les suffixes et préfixes utilisés :

’ Objets \ Suffixes ‘
constante _C
variable v
port entrée i
port sortie _0
port entrée/sortie _io

signal interne :
architecture textuelle VHDL _s
architecture interne (schéma bloc) -

spécifique pour banc de test (test-bench) :

signaux de stimuli _sti
signaux observés _obs
signaux de référence _ref

TABLE A.1 — Liste des suffixes utilisés au REDS

] Polarités \ Préfixe \ Exemple ‘
signaux actif haut - Up.i
signaux actif bas n’ nUp_i
signaux double 'n’ devant second nom | Up_nDn_i

TABLE A.2 — Liste des préfixes utilisés au REDS

A.2 Résumés des flows de simulation
A.2.1 Simulation manuelle avec la console

— Depuis le Design Manager, cliquer sur le Top_Sim pour ouvrir la vue structurelle (schéma).
— Ajouter et Connecter le composant a simuler dans le Top_Sim.
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— Vérifiez que Parchitecture a simuler est celle sélectionnée par défaut dans le Design Manager.
— Depuis le Design Manager, sélectionnez le composant Top_Sim.

— Cliquez sur Compile dans la fenétre Tasks (en haut & gauche dans le Design Manager).

— Cliquez sur Simulate dans la fenétre Tasks.

— Dans la fenétre qui apparait, validez en cliquant sur OK. Le simulateur ModelSim se lance.

— Dans la fenétre de ModelSim, cliquez sur le bouton REDS_console pour ouvrir celle-ci.

— Ajouter les signaux du composant & simuler (pas ceux de Top_Sim) dans la fenétre Wave.

— Choisir 1'état des entrées désirées dans la console (interrupteur ou valeur).

— Activer un pas de simulation en cliquant sur le bouton RUN.

— Répéter ces 2 derniers points pour toutes les combinaisons a tester.

A.2.2 Simulation automatique

— Vérifiez que I'architecture a simuler est celle sélectionnée par défaut dans le Design Manager.

— Depuis le Design Manager, sélectionnez le test-bench du composant a simuler, portant le nom
NomComposant_tb.

— Cliquez sur Compile dans la fenétre Tasks (en haut & gauche dans le Design Manager).

— Cliquez sur Simulate dans la fenétre Tasks.

Dans la fenétre qui apparait, validez en cliquant sur OK. Le simulateur ModelSim se lance.

— Ajoutez les signaux dans la fenétre Wave.

Lancez la simulation
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